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AppleLink—Personal Edition License
Agreement

PLEASE READ THIS DOCUMENT CAREFULLY
BEFORE OPENING THE REGISTRATION
CERTIFICATE. YOU ARE AGREEING TO
BECOME BOUND BY THE TERMS OF THIS
AGREEMENT, WHICH INCLUDES THE
SOFTWARE LICENSE AND DISCLAIMER OF
WARRANTY. IF YOU DO NOT AGREE TO THE
TERMS OF THIS AGREEMENT, DO NOT OPEN
THE REGISTRATION CERTIFICATE.
PROMPTLY RETURN THE SOFTWARE
PACKAGE TO THE PLACE WHERE YOU
OBTAINED IT FOR A FULL REFUND.

THE ENCLOSED COMPUTER PROGRAM
(*"APPLELINK—PERSONAL EDITION
SOFTWARE") AND THE DISK ON WHICH IT IS
RECORDED ARE LICENSED, NOT SOLD, TO
YOU FOR USE ONLY UNDER THE TERMS OF
THIS LICENSE, AND QUANTUM COMPUTER
SERVICES, INC. ("QUANTUM") AND/OR
APPLE COMPUTER, INC. ("APPLE*) RESERVES
ANY RIGHTS NOT EXPRESSLY GRANTED TO
YOUu.

1. License. This License allows you to:

(a) Use the AppleLink—Personal Edition
Software only on a single Apple computer.

(b) Make one copy of the AppleLink—Personal
Edition Software in machine-readable form
solely for backup purposes. The
AppleLink—Personal Edition Software is
protected by United States copyright law. You
must reproduce on each copy the Quantum
and/or Apple copyright notice and any other
proprietary legends that were on the original
copy.

2. Restrictions. You may not distribute copies
of the AppleLink—Personal Edition Software to
others or electronically transfer the
AppleLink—Personal Edition Software from
one computer to another over a network. The
AppleLink—Personal Edition Software contains
trade secrets and in order to protect them you
may not decompile, reverse engineer,
disassemble, or otherwise reduce the
AppleLink—Personal Edition Software to a
human-perceivable form. YOU MAY NOT
MODIFY, ADAPT, TRANSLATE, RENT, LEASE,
LOAN, RESELL FOR PROFIT, DISTRIBUTE,
NETWORK, OR CREATE DERIVATIVE WORKS
BASED UPON THE APPLELINK—PERSONAL
EDITION SOFTWARE OR ANY PART
THEREOF OR ANY MANUALS OR
DOCUMENTATION RELATED THERETO.

3. Termination. This License is effective until
terminated. This License will terminate
automatically without notice from Quantum
and/or Apple if you fail to comply with any
provision of this License or the AppleLink—
Personal Edition Terms of Service contained on
line. Upon termination you must destroy the
Applelink—Personal Edition Software and all
copies thereof. You may terminate this License
at any time by destroying the AppleLink—
Personal Edition Software and all copies
thereof.

4. General. This Agreement will be construed
under the laws of the Commonwealth of
Virginia, except for that body of law dealing
with conflicts of law. If any provision of this
Agreement shall be held by a cournt of competent
jurisdiction to be contrary to law, that provision
will be enforced to the maximum extent
permissible, and the remaining provisions of
this Agreement will remain in full force and
effect.

Limited Warranty and Limitations of
Warranty and Liability

A. Limited Warranty on Media and
Manuals. Quantum warrants the disks on which
the AppleLink—Personal Edition Software is
recorded and the manuals distributed with the
AppleLink—Personal Edition Software to be
free from defects in materials and faulty
workmanship under normal use for a pericd of
ninety (30) days from the date of purchase as
evidenced by a copy of the receipt. Quantum
will, at its option, replace or refund the
purchase price of the disk at no charge to you,
provided you return the faulty disk with proof
of purchase to Quantum or an authorized
AppleLink—Personal Edition dealer. Quantum
and/or Apple shall have no responsibility to
replace or refund the purchase price of a disk
damaged by accident, abuse, or misapplication.
ANY IMPLIED WARRANTIES ON THE DISKS
AND MANUALS, INCLUDING IMPLIED
WARRANTIES OF MECHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, ARE
LIMITED IN DURATION TO 90 DAYS FROM
THE DATE OF PURCHASE.

B. Disclaimer of Warranty. THE
APPLELINK—PERSONAL EDITION
SOFTWARE IS PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING WITHOUT
LIMITATION ANY WARRANTY WITH
RESPECT TO ITS MERCHANTABILITY OR ITS
FITNESS FOR ANY PARTICULAR PURPOSE.
THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE APPLELINK—
PERSONAL EDITION SOFTWARE IS WITH
YOU. SHOULD THE APPLELINK—PERSONAL
EDITION SOFTWARE PROVE DEFECTIVE,
YOU (AND NOT QUANTUM AND/OR APFLE
OR THEIR AUTHORIZED REPRESENTATIVES)
ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR, OR
CORRECTION.

QUANTUM AND/OR APPLE DOES NOT
‘WARRANT THAT THE FUNCTIONS
CONTAINED IN THE APPLELINK—PERSONAL
EDITION SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THE OPERATION
OF THE APPLELINK—PERSONAL EDITION
SOFTWARE WILL BE UNINTERRUPTED OR
ERROR-FREE OR THAT DEFECTS IN THE
APPLELINK—PERSONAL EDITION
SOFTWARE WILL BE CORRECTED.

SOME STATES DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES, SO
THE ABOVE EXCLUSION MAY NOT APPLY TO
YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS AND YOU MAY ALSO HAVE
OTHER RIGHTS, WHICH VARY FROM STATE
TO STATE.

C. Limitations of Warranty. THE LIMITED
WARRANTIES PROVIDED IN PARAGRAPH A
ABOVE ARE THE ONLY WARRANTIES OF
ANY KIND THAT ARE MADE BY QUANTUM
AND/OR APPLE ON THIS QUANTUM
PRODUCT. NO ORAL OR WRITTEN
INFORMATION OR ADVICE GIVEN BY
QUANTUM AND/OR APPLE OR AUTHORIZED
APPLELINK—PERSONAL EDITION DEALERS,
DISTRIBUTORS, AGENTS, OR EMPLOYEES
SHALL CREATE A WARRANTY OR IN ANY
WAY INCREASE THE SCOPE OF THIS
WARRANTY, AND YOU MAY NOT RELY ON
ANY SUCH INFORMATION OR ADVICE. THIS
WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS. YOU MAY HAVE OTHER RIGHTS,
WHICH VARY FROM STATE TO STATE.

D. Limitation of Liability. IN NO EVENT
WILL QUANTUM AND/OR APPLE BE LIABLE
(i) TO YOU FOR ANY INCIDENTAL,
CONSEQUENTIAL, OR INDIRECT DAMAGES
(INCLUDING, BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF
PROGRAMS OR INFORMATION STORED ON
THE DISK, AND THE LIKE) ARISING OUT OF
THE USE OF OR INABILITY TO USE ANY
APPLELINK—PERSONAL EDITION
SOFTWARE OR THE DISK ON WHICH IT IS
RECORDED, EVEN IF QUANTUM AND/OR
APPLE OR THEIR AUTHORIZED
REPRESENTATIVES HAVE BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES, OR (iD)
FOR ANY CLAIM BY ANY OTHER PARTY.

BECAUSE SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF LIABILITY
FOR CONSEQUENTIAL OR INCIDENTAL
DAMAGES, THE ABOVE LIMITATIONS MAY
NOT APPLY TO YOU.

QUANTUM'S AND/OR APPLE'S LIABILITY TO
YOU FOR ACTUAL DAMAGES FOR ANY
CAUSE WHATSOEVER, AND REGARDLESS OF
THE FORM OF THE ACTION, WILL BE LIMITED
TO THE GREATER OF $50 OR THE MONEY
PAID FOR THE APPLELINK—PERSONAL
EDITION SOFTWARE THAT CAUSED THE
DAMAGES OR THAT IS THE SUBJECT MATTER
OF, OR IS DIRECTLY RELATED TO, THE
CAUSE OF ACTION,
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QUANTUM COMPUTER
SERVICES, INC.

This manual and the software
described in it are copyrighted,
with all rights reserved. Under
the copyright laws, this manual
or the software may not be
copied, in whole or part, without
written consent of Quantum,
except in the normal use of the
software or to make a backup
copy of the software. The same
proprietary and copyright
notices must be affixed to any
permitted copies as were affixed
to the original. This exception
does not allow copies to be made
for others, whether or not sold.
Under the law, copying includes
translating into another language
or format,

You may use the software on any
computer owned by you, but
extra copies cannot be made for
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Preface

Your AppleLink®—Personal Edition program disk will work with
these computer systems:

O an Apple IIGS® computer

0 an Apple® Ile computer with at least 128K of RAM, enhanced
ROM, an 80-column card, and either a Super Serial Card or an
internal modem

O an Apple IIc computer

If your computer doesn't have an internal modem, you'll need a
modem too. You'll also need a standard telephone wall jack into
which you can plug your modem.

If you'd like a general overview of the activities, entertainment, and
services available on AppleLink, please turn to Chapter 1 in this
guide.

For a detailed description of all the preparations you need to make
before using AppleLink, please turn to Chapter 2 of this guide.
You'll use some of the phone numbers listed in the AppleLink
Connect Guide and the information printed on your AppleLink
Registration Certificate.

For step-by-step instructions on an activity or a task, turn to
Chapter 3 in this guide.

Wonder what a word or phrase means? Turn to the glossary at the
back of this guide.

For a reminder of important Keywords and commands, look at your
AppleLink Quick Reference Card.




% By the way: If you're already familiar with modems and
telecommunication and you just want to get going fast, use the
AppleLink Comnect Guide. That guide provides you with the
essential steps for setting up your equipment, preparing your
disk, signing on, and registering.
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Chapter 1

Welcome to Applelink

Welcome to a new kind of community, made possible by the
AppleLink® application. With AppleLink—Personal Edition, you
can easily chat with other owners of Apple® computers through
your computer. You can get support and information, carry on
private conversations, trade ideas and advice. You can exchange
documents, public-domain software, questions and answers. You
and other users of AppleLink learn together, play games together,
participate in free-ranging discussions together.

With AppleLink, you're on /ine. That means you're communicating
via your computer, over phone lines, to a much larger computer,
which acts as a host for everyone who's signed on. Through the host
computer, you can chat with a group of people, post messages for
all the other people in a special interest group to read and comment
on, listen in on experts discussing exciting developments, or send
memos and notes back and forth. Communication takes place
immediately, electronically—and in these exchanges, you will be
talking via AppleLink to people all across the country.

Using the AppleLink software takes you into two new worlds—the
Apple Community, in which you’ll find out how to get the most out
of Apple products; and General Services, in which you can range
freely through activities stretching from auctions to zoology. And
there’s a Post Office to help you send messages to anyone else who
signs on—wherever they are.

In addition to being on line, you can work off line to prepare for
your on-line session. Off line means you've started up AppleLink,
but haven't signed on yet.




In this chapter, you’ll get an overview of the many activities possible
on line and off with AppleLink.

APPLE GEHERAL
COMMUNITY SERVICES

Figure 1-1
The Applelink worlds

The Apple Community

Let’s look at the Apple Community first. The on-line Apple
Community constantly grows and changes, responding to your
needs and requests. Here'’s a sampling of the kind of ongoing
activities that you'll find here.

Applelink University

Enroll in a course, and learn how to get the most out of software for
your Apple or how to program your computer. Get a quick overview
of the courses on line, visit the AppleLink U. library for study
materials, talk things over with fellow students and instructors via an
electronic message board, then join the instructor on-line for a
lively discussion. You don't have to leave your house for these
courses, and you can read the materials and use the message boards
any time, day or night.

Chapter 1: Welcome to Applelink
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Apple Forums

Meet with other people who want to know the latest and greatest
about the Apple II, about the Macintosh® computer, about
software. Post your question on the forum message boards; come
back later, and you may find half a dozen answers. Participate in
live technical discussions, or listen while the Apple Forum leaders,
who are experts in computing, bring you up to date.

Apple Headquarters

Connect with Apple’s Cupertino campus in California, and talk
directly with Apple employees in the Apple Cafe. Get quick
solutions, hot tips, and news about recent products and
promotions, right from Apple. Buy Apple T-shirts, Apple mugs,
Apple beach towels—all those necessities of life—from the Apple
Collection®™.

Industry Connection

Find out what's happening at your favorite hardware and software
companies. Join a group meeting about your favorite game
program, talk to the programmer. Listen to experts talking about
trends in the business or new ways to make use of their applications.
Or browse before you buy—pick up a demonstration version of a
new program to see if you like it well enough to buy the real thing.

Software Center

Browse through a library of software that’s in the public domain. In
a few minutes, you can take home a game, a utility, or an
application. Test out some shareware, and if you decide to use the
program, send the creators a contribution.

Reference Library

Have a technical question about an Apple product? This is the place
to get all the information. You'll find clear and detailed solutions to
common problems, assistance on that program you're developing,
copies of Apple’s own manuals. Read reviews of software,
contributed by other members.

The Apple Community 3




Calendar and Events

Find out what’s happening on AppleLink tonight—or in the month
to come. Check “Best Bets” for nightly events or “Don’t Miss” for
descriptions of special events, contests, and conferences coming

up.

General Services

This is the other half of the on-line world—devoted to topics of
more general interest. Here are a few of the many ongoing activities
you'll find in the area of General Services.

People Connection

This is your social center. Come on in; during evening and weekend
hours, there’s an AppleLink Guide in the lobby to direct you to
whatever service or event you want. Or wander around, looking into
the public rooms in which members are discussing current events,
exchanging gossip or information on special topics, playing on-
line games together, having a party, or just chatting away. You can
join in or create your own room and invite folks in. When you find
someone you want to talk to alone, you can create a private room.
Or go to the Auditorium for conferences, guest lecturers, and game
shows.

Financial District

Follow the markets. Check how your stocks are doing on the New
York Stock Exchange, American Stock Exchange, or over the
counter, using StockLink. Join the Investor’s Network and share
financial strategies with experts and other AppleLink members.

Recreation Center

Play interactive games with someone who lives next door or across
the continent. Get the latest entertainment and sports news. Share
your own book, movie, and concert reviews.

00T 0
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Club House

Find friends who understand and share your love of sports,
photography, astronomy, and more. Become a dragon, a knight,
or a dangerous damsel in the Phantasy Guild's role-playing
adventures. Or just hang out and talk.

News Room

Keep up to date on local and national news, politics, economics,
and the weather. Read the headlines hot off the wire. Share your
ideas on the Opinion Poll message board or join a lively debate
about the major issues of the day with other participants, using the
Express Yourself message board.

The Mall

No problem parking at this mall. Stroll around and check out the
low prices on televisions, stereos, microwaves, and other items.
Skim the classified ads for bargains posted by other members. Look
up the lowest airfares, and make flight, rental car, or hotel
reservations. Pick out a bouquet, and have the flowers delivered to
someone special.

Customer Service

Find out about special AppleLink events and schedules. Get
information about all of the AppleLink features and functions in the
Members’ Online Guide. Add new screen names for yourself or
members of your family. Check your bill here. And be sure to read
the AppleLink Terms of Service.

Learning Center

Take a course without leaving home; take up a subject that has always
interested you. Get tutoring help with your homework. Look up
those key facts in the 20-volume Grolier's Academic American
Encyclopedia.

General Services 5




The Post Office

The AppleLink Post Office acts the way the real one ought to—you
get messages right away. And you can send several kinds of
electronic correspondence to anyone else who's a member of
AppleLink. You can dispatch a FlashNote—a brief, private message
that will appear on the screen for someone else who is currently on
line. You can send letters to other people, for them to read at their
convenience. You can even send disk files to other members.

When you’re trying to reach friends, the AppleLink electronic mail
service lets you avoid phone tag. You can leave a detailed message,
instead of the traditional “Please call!” With the AppleLink Post
Office, you'll find you can communicate more, faster.

The off-line world

Sometimes you'll want to do some work before you sign onto
AppleLink. Your AppleLink software helps you do this work off
line—that is, right on your own computer, before you connect to
AppleLink.

Work Offline

The AppleLink software helps you format a disk, identify which disk
is in which drive, find out which files are on a particular disk, and
delete, rename, lock, or unlock files. You can even create a
directory or set up a prefix—a pathname leading your computer to a
particular location on one of your disks—for convenient access.

Off line, you can compose a memo—then you can get on line and
send your memo out through the Post Office, post it on a message
board, use it as a file description in a software library. When you
work off line, you’re ready to send out your memos as soon 4s you
connect to AppleLink.

0
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Figure 1-2
Choosing Work Offline from the Sign On screen

Set-up

The first time you use your AppleLink software, you must tell it what
phone number to call and what kind of modem you are going to be
using to get through to AppleLink. You work off line to set up this
information.

Set Options

You can fine-tune the way AppleLink displays menus and
conversations. You get to tailor the screen to your taste.

The off-line world Z




Applelink keeps on growing

AppleLink is an expanding universe that's easy (o navigate. You
meet interesting individuals, learn an amazing amount, and g=t 2.
whole new perspective on your own world.

Your ideas help expand AppleLink services, creating new
conferences, discussions, clubs, and courses. You may start as a
listener and then become a participant, contributing ideas of your
own. That’s just what AppleLink is designed to encourage. You add
to it, change it, improve it, make it your own. AppleLink grows with
you.

< By the way: The AppleLink icons will appear in full color, as
pictured on the software package, when using AppleLink with an
Apple 1IGS® computer with at least 512K memory. On other
Apple II systems the icons will be slightly different in design and
appear in black and white.

Chapter 1: Welcome to Applelink
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Figure 2-1
Data leaving through the
serial port

Chapter 2

Getting Started

To get ready to use AppleLink for the first time, you need to
understand a little about the way information will flow from you to
the AppleLink host computer and back.

The flow of information

Let's say you begin by doing some work on your computer—perhaps
you write a short note or a memo, using your working copy of the
AppleLink—Personal Edition program disk.

Then you tell AppleLink that you want to go on line. Your message
goes out of your computer through a connector known as a serial
port. (This port is serial because the data gets transmitted
sequentially, one unit at a time, over a single wire; the printer and
telephone ports are both serial ports.)

The message then zips through a cable to a device called a modem,
which translates the signals so that they can travel along the phone
lines. To understand each other, your computer and your modem
need to be talking at the same speed, and starting and stopping at
the same times. So you'll need to prepare your computer to
communicate with the modem—and hock up the modem before
you begin using AppleLink.




Figure 2-2

Data being translated in the
modem and then sent out
along the phone lines

Figure 2-3

Data flowing back info the
modem and then into the host
computer

10 Chapter 2: Getting Started

From the modem, your message follows the phone lines into your
wall, down the street, and away. Your message goes [0 a company
that specializes in sending and receiving a lot of this kind of
electronic data—a network. So another part of getting ready
involves telling your AppleLink program what network to call and
what phone number to use.

The network speeds your message to the AppleLink host computer.
When your message reaches the AppleLink host computer, it meets
another modem. Where your own modem “modulated” your
message so that it could travel over the phone lines, this modem
“demodulates” the message, unscrambling it for the host
computer.

The host responds, checks your AppleLink disk, then issues a
welcome. All this communication, often across the continent, takes
a few seconds.

You may want to keep this background in mind as you get ready to
use AppleLink for the first time. You'll take the following steps,
described in the rest of this chapter:

1. Making a working copy of your AppleLink disk and putting your
original in a safe place. (That way, if anything happens to the
working copy, you can always make a new one immediately.)

2. Preparing your computer to go on line. (This may involve
changing a few settings.)

3. Hooking up your modem (plugging it in).

4. Setting up your AppleLink disk with the right telephone numbers
to call. (You enter a local access number to call, so you can
avoid long-distance charges.)

5. Registering. (This step is like checking in at a hotel for the first
time, answering questions about your real name and address and
your preferred method of payment.)

You need to go through these steps only once. You won't have to
repeat any of them unless you move to a new location or change
equipment. Within a little while, you’ll have done everything you
need to enjoy life with AppleLink.

0 0 00 8 8 )
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1. Making a working copy

Before you begin, you should make a working copy of the AppleLink
program disk, then save your original in a safe place, far from the
threat of sunlight, dust, magnets, and soft drinks. That way, if
anything happens to your working copy, you can always create a new
one.

You can use the Apple II System Utilities to duplicate your
AppleLink program disk, known to the utilities as the source disk.
You copy its contents onto another disk, known as the destination
disk. For the destination disk, use a brand-new disk; you know it's
clean and you’re sure it doesn’t contain any key information that
would get written over during duplication.

If you have only one disk drive

If you have only one disk drive that can handle disks like your
AppleLink program disk and if you have a recent copy of the

Apple Il System Disk, you should choose Fast Copy on the System
Disk menu (on the Apple ITe or Apple IIc) or in the System Utilities
folder (on the Apple IIGS), and follow the on-screen directions.
(Fast Copy lets you avoid a lot of disk swapping.)

If you have only one drive and don’t have Fast Copy available,
choose the Copy Files command in the Main Menu of the System
Utilities application and follow the directions. You will have to swap
disks back and forth many times, but please be patient and comfort
yourself with the thought that you have to go through this form of
disk calisthenics only once.

If you have two disk drives

Follow these steps to make a working copy of your AppleLink
program disk.

1. Put your System Utilities disk in your main drive and turn on
the computer.

Your System Ultilities allow you to make a copy of the AppleLink
program disk on another disk. Some versions start with a System
Disk menu; others go right to the System Utilities Main Menu.

1. Making a working copy 11




2. If you see a System Disk menu, choose System Utilities.

3. In the Main Menu for your System Utilities, choose Duplicate
a Disk and press Return.

You cannot use the Duplicate a Disk command to copy the
contents of a 3.5-inch disk onto a 5.25-inch disk or vice versa.
You can use Copy Files to copy each and every file, one at a time,
between disks of different sizes.

{0

4. Write-protect the original Applelink program disk and put it
in place of the System Utilities disk.

5. Specify the location of your Applelink program disk.

Your computer asks you where the AppleLink program disk is.
Usually, the utilities program suggests the slot and drive numbers
that refer to the main drive, so you can just accept those by
pressing Return. Most commonly, your main drive is connected
to slot 6 as drive 1. If you have a different arrangement, just enter
the right slot and drive numbers now.

For information about the inner mysteries of slots and drives,
please see your guide to the System Utilities or the owner’s
manual for your computer.

6. Specify the location of the destination disk (the disk you're
going to turn into a working copy of the Applelink program
disk).

This is the disk onto which you’ll copy the AppleLink program.
You now see a message asking you to insert the source and
destination disks.

7. Make sure you have the Applelink program disk in the main
drive and the blank disk in the other drive. Then press
Return.

4 ¢

You see the message “Done.”

8. Remove your original Applelink program disk and store it in a
safe place.

9. Remove your working copy and create a label for it such as
“AppleLink—Working Copy.”

1

This is the disk you should use from now on.

Warning Do not write-protect your working disk.

12 Chapter 2: Getting Started
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2. Preparing your computer
and equipment

Now you may need to make a few adjustments to your computer
system. (If your modem and printer are already set up and working,
you can skip this section and the next and go on to “Setting Up
AppleLink.™)

If you want to use an ImageWriter® or ImageWriter II printer,
connect its data cable—the one that carries information from the
computer—to the printer port on the back of your computer. (If
your computer has icons, the icon above this port shows paper
coming out of the top of the printer.) Connect the power cable to an
electric outlet.

Here’s how o prepare your Apple IIGS, Apple Ile, or Apple Ilc
systems.

Preparing an Apple lles

To communicate using your modem, you need to tell your
Apple 1IGS exactly how fast to send the data to your modem and in
what form. You use the Control Panel to establish these settings.

1. Press Command-Control-Esc.

% Note: The Command key is the key marked with an open
apple. When keys are joined with hyphens, it means to press
them simultaneously.

Pressing these keys brings up the Desk Accessories menu.

2. Choose Control Panel.

That's where you’ll make your changes.

3. Choose Modem Port.

2. Preparing your computer and equipment 13




4. Make sure that the options are set like this:

v Device Connected Modem

¢ Line Length Unlimited

v’ Delete first LF after CR No

v/ Add LF after CR No

v’ Echo No
Buffering Yes
Baud 300, 1200, or 2400

¢’ Data/Stop Bits 8/1

v Parity None
DCD Handshake No
DSR/DTR Handshake No

¢ XON/XOFF Handshake No

Most of these are the standard settings, indicated by the check
mark next to them. (The only variations from standard are for
Buffering, Baud, DCD Handshake,and DSR/DTR Handshake.) If
you'd like explanations of these strange terms, see the section on
the Control Panel in your Apple IIGS Owner’s Guide or the

Apple 1IGS System Disk User’s Guide.

5. Press Return to save these settings and return to the Control
Panel menu. Choose Printer Port.

6. You must also set up the printer port, even if you aren’t
planning to use a-printer. Make sure that the oplions are set

like this:

v Device Connected Printer

v’ Line Length Unlimited

v’ Delete first LF after CR No

v’ Add LF after CR Yes

v Echo No
Buffering Yes

v Baud 9600

v’ Data/Stop Bits 8/1

v’ Parity None
DCD Handshake No

DSR/DTR Handshake No
v XON/XOFF Handshake No

7. Press Return to confirm your settings and quit the Control
Panel.

AEEAEEA AR RA A AR AR RN
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Preparing an Apple lle

When you're using AppleLink on an Apple Ile, your messages will go

out through an internal modem (a modem on a card) or through

the Apple Super Serial Card (or compatible) to an external modem

(one that sits outside your computer), and then across the phone

lines. Before you install the serial card, you need (o set its switches

correctly.

Make sure that you don’t touch the gold fingers at the bottom of the

card. The moisture and oil in your skin could interfere with the

card’s ability to transmit signals accurately.

As you look at the serial card, you see two sets of little switches that

move up and down. ON is UP, and OFF is DOWN. If your switches f
push in and out instead, a switch is considered ON when it is UP and
IN, OFF when it is DOWN and IN.

Occasionally, you'll encounter a card that has some switches
labeled OPEN and CLOSED. A switch can carry a current only when
its connections are brought together, or closed; so a switch is ON
when it is CLOSED, and OFF when it is OPEN.

On the left Set the switches in the left bank like this:

1 2 3 4 5 6 7
GFE L . ON: TONS ONs (G ON - 1ON - ON

On the right Set the switches on the right side like this:

1 2 3 4 5 6 ¥
ON OFF. ON , .ON OFF ON OFF

And finally... Elsewhere on the serial card, you'll find a small
black plastic block called a jumper, near the labels MODEM and
PRINTER. That’s because this card most often serves either a
modem or a printer. You need to make sure that the jumper is
pointing toward MODEM.

Everything set? Now you can fit the card into its slot, following the
directions in your serial card manual.

Preparing an Apple lic

No problem. Your Apple IIc is all set up and ready to go. Just hook
up your modem, as described in the next section.

2. Preparing your computer and equipment 15




Figure 2-4
Connecting to a phone jack

3. Hooking up your modem

When you send a signal out from your computer across the phone
lines, you need a modem to adapt your messages so they can zip
through the phone lines. Some modems have a series of switches
you need to set so they can communicate correctly with your
computer; please consult the AppleLink Connect Guide for these
settings and make any adjustments before proceeding.

Some modems exist inside your computer (they’re known as
internal modems), but most are external modems. In hooking up
any external modem, you go through three main steps.

1. Connect your computer to your modem.

You use a cable sometimes known as a data cable. This cable,
which probably came with your modem package, carries data
from the computer to the modem and back again.

On the Apple Ilc or Apple 1IIGS, you plug one end of this cable
into your computer, using the socket with the image of the
telephone over it—the phone port. (On the Apple IIGS this port
is also known as slot 2.) With an Apple Ile, you plug this cable
into the socket dangling from slot 2 of your Apple Super Serial
Card (or compatible).

The other end of the cable may be permanently attached to your
modem, or you may have to plug it into the modem. For more
details on the cable and its connections, please see your modem
manual.

2. Connect the modem to a working telephone outlet (or jack).

To carry the messages from the modem to the standard phone
line, you use another cable just like the one that links your regular
telephone to the jack. Plug one end of this cable into the
telephone jack, then plug the other end into the modem. (If one
of the sockets on your modem is labeled LINE, plug the cable
into that. If both sockets look the same and have no labels, use
either one.)

With some modems, you have to disconnect your phone’s cable
from the telephone jack, then plug in your modem’s cable to go on
line. Other modems let you plug the cable from your phone right
into the back of the modem and make ordinary phone calls when
you are not using the modem for on-line work. See what the modem
manual says.

16 Chapter 2: Getting Started
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% By the way: If you have the service known as Call Waiting, you'll
need to disable that before you connect to AppleLink or you will
be disconnected from AppleLink whenever you receive a
telephone call. To disable your Call Waiting service, choose Set
Up from the Sign Up menu, then choose Set Up Phone, and
insert the number 1170 and a comma before the local access
number. (Don't forget the comma.) Then sign on again. If an
incoming phone call disconnects you from AppleLink, ask your
local phone company how to disable Call Waiting.

3. Plug the modem into an electrical outlet.

Plug the electrical cord or the AC/DC adaptor into an electrical
outlet. You can leave your modem plugged into the electrical
outlet all the time, like a toaster, and just turn the modem on or
off as needed.

4. Setting up Applelink

You won’t want to call AppleLink directly because that would involve
long-distance charges. Instead, you'll use one of AppleLink’s many
local access numbers. These phone numbers connect you to an
access network specially designed to carry computer messages at
much greater efficiency than the regular phone system can
handle—and so at much lower cost.

In this section, you'll tell AppleLink the local phone numbers of
your local access networks. In addition, if you don't have a
touchtone phone or a standard modem, you can tell AppleLink to
take that into account

1. Put your working copy of the Applelink—Personal Edifion
program disk in the main drive of your computer and turn the
power on.

If the power is already on, hold down the Command key while
you press Control and Reset.

Release the Reset button just before you release the other two
buttons.

4, Setting up Applelink 17




After the computer starts, you see the Sign On screen.

Figure 2-5
The Sign On screen

2. Choose Set Up from the menu.

Use the arrow keys or the mouse to highlight Set Up, then press
Return or click the mouse.

3. Choose Set Up Phone on the Set Up menu.

Use the arrow keys or mouse to highlight Set Up Phone, then
press Return or click the mouse. You see the Phone Set Up box.

‘ ‘ ' 1 4 LT
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Use the Connect Guide to find your local access number. Type it in and
specify the network. If two local numbers are available, enter both
(the second number will be dialed if the first is busy). If there

is no access number listed for your city, check odjacent towns;

one may be listed there. Be sure the number(s) you enter are in your
local calling area.

Use the TAB key to switch between sections, and arrow keys to make

a selection.

Phone Number #1i: Phone Number #2:
5591212 7035551212
B Telenet H Telenet
H Tymnet H Tymnet
[ Datapac @ Datopac
B Other 0 Other
[ &1 Cancel (ESC) B 2 Save Phone Information
O &3 Help (&&7)

Figure 2-6
The Phone Set Up box

You're going to enter a network access number you know is local, so
you can avoid long-distance charges.

4. Turn to the directory of access numbers in the back of the
Applelink Connect Guide.

This guide is a state-by-state listing of all the telephone numbers
you can use to connect to AppleLink, plus the name of the
network providing the service for each number. Pick the phone
number of the fastest nearby service your modem can handle: If
your modem can communicate at 300 or 1200 baud, pick a
300/1200-baud network number; if your modem can
communicate at 2400, choose a 2400-baud network number. To
save money and to keep the conversation lively, you’ll want to
telecommunicate as quickly as you can.

5. Type the phone number.

If you want to correct a mistake, use the Delete key to back up and
start over.

If you have to dial a particular digit to get an outside line, enter
that digit followed by a comma; the comma tells AppleLink to

pause for a moment after the first digit, waiting for the outside

line. For instance,

9,6661212

4. Setting up Applelink 19
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If you must dial outside your local area, include the area code
without punctuation, running right into the phone number like
this:

4155551212

If you must dial outside your local area, you will incur long-
distance phone charges. Local calls will be billed at the same rate
as local “voice” calls.

. Tab to the list of access networks.

. Use the Down Arrow or Up Arrow key or the mouse to move

the highlighting to the network whose number you've just
entered. Then press the Right Arrow key or click the mouse
to choose that network.

. Tab to the next box and enter the telephone number of a

second local access network if one is available at your
preferred baud rate.

If for some reason AppleLink cannot make a connection by using
the first number, it will automatically dial the second number.

. Press Command-2 to save this information on your disk.

A message confirms that your phone information has been
changed.

10. To return to the Set Up menu, press Command-Esc.

11. To enter information about your modem, choose Set Up

Modem from the Set Up menu.

Chapter 2: Getting Started
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If you are using a 1200 baud Hayes-compatible modem, and you have
touch tone phone service, you need not alter this screen. Just
press 31 to continue.

If you need to change these settings, use the TAB key to switch
between sections and arrow keys to make selections.

Boud Rate Phone Type Modem Type

o 300 B Tone O Manual dial y

m1200 d Pulse B Other Hoyes compatible

B 2400 B Hayes compatible (standard)
[ Micromodem Ile

B &1 Cancel (ESC) B 2 Save Modem Settings
B &3 Help (G7)

Figure 2-7
The Set Up Modem box

12. Choose your baud rate, phone type, and modem type.

Pick the highest baud rate your modem can handle. If you have a
rotary-dial phone, pick Pulse; if you hear beeps when you dial,
choose Tone. Apple modems are Hayes-compatible
(standard).

If you want to dial out yourself, using standard Hayes modem
commands, choose Manual dial.

13. Press Command-2 to save this information on your disk.

You get the message “Your modem information has been
changed.”

14. To return to the Set Up menu, press Command-Esc.

15. If you are using a nonstandard serial card or internal modem,
choose Change Slot Settings from the Set Up menu and
press Command-2 to adjust settings to work with your
modem. Enter the number of the slot you'll be using.

16. Select Apple llc, Apple lics, or, if you have an Apple lle, the
Super Serial Card or MicroModem lle. If you are using an
infernal modem other than MicroModem lle, select the
Super Serial Card. Then press Command-2 to save this
information.

17. Press Esc three times to close the Set Up menu.

4. Setting up Applelink 21




18. To return fo the Applelink Sign On screen, press the Right
Arrow key or use the mouse to open the Go To menu, press
Return to open the menu, then press Return again to

choose Go to Sign-On Menu command. E- !

% Note: If you ever melt your working copy on a radiator or suffer
some such unfortunate accident, you'll be able to make a new
working copy from the original AppleLink—Personal Edition
program disk; just remember to add all this information to that
disk, too. You will need to call AppleLink Customer Service at
1-800-227-6364 before using your new disk.

5. Registering

Like a guest checking into a hotel, you need to register the first time
you sign onto AppleLink. Basically, you confirm your name and d
address, pick a name by which you’ll be known on the network (a

screen name), and choose a method of payment. If you want

payments deducted from your bank account using the

CHECKFREE® payment program, have your checkbook handy; if d
you prefer to use VISA® or MasterCard®, have your card nearby.

With your AppleLink materials, you should have received a
Registration Certificate containing your registration code and
password. Have it handy before signing on to register.

1. Place your working copy of the Applelink program disk in the
main drive and turn your computer on.

If the computer is already on and you’re in either the Set Up, Set
Options, or Work Offline area of AppleLink, return to the
AppleLink Sign On screen by choosing the Go to Sign-On Menu
command from the Go To menu.

2. Choose Sign On.

The computer makes contact with the AppleLink host computer,
which asks you for your Registration Certificate information.

If you chose manual dialing when you set up your modem,
choose Sign On. You get the message “You may now enter your
commands.” Use standard Hayes modem commands to tell the
modem to activate, search for a dial tone, and dial the local
access number. Type atdt<access number>. The modem
dials AppleLink and reports the connection. Press Command-T
and select the Options menu. Choose Resume Connecting.

22 Chapter 2: Getting Started




1,001 L L L T L 1T 1T 1 L 1T T T ¥ 0121 1 1 . . 1,

Your screen shows you what is happening as AppleLink dials,
makes a connection with the host computer, checks your
password, and verifies your disk. If anything goes wrong, make
sure your modem is turned on, connected to your computer, and
plugged into the standard telephone jack on the wall. If it is, go
back to the Sign On screen, choose Set Up, then choose Set Up
Phone, and make sure that you have entered the correct local
phone numbers for your network access.

Welcome to Applelink - Personal Edition]

Please enter the following information:

Registration Certificate code;

12-3u56-7890

Certificate password:

my-password_

@ <1 Send Certificate Information

Figure 2-8
The registration form

3. Type your Applelink registration code.
It's on your AppleLink Registration Certificate.

4. Press Tab and type your password.

Copy the words exactly as they appear on your certificate.

5. Press Command-1 to send this information.

If you have difficulty at this point, please call 1-800-227-6364 for
AppleLink Customer Service.

The Applelink host computer confirms that it recognizes your
registration code and password and asks for your name, address,
and phone number for billing purposes.

5. Registering 23




6. Enter the information requested and press Command-1 to
send it.

Use Tab to move from field to field. After these questions,
AppleLink asks you which method of payment you prefer.

7. Choose a method of payment, and press Command-1.

If you'd like to use a credit card, press Command-1 to choose
VISA or press Command-2 to choose MasterCard, then enter
your account number and the expiration date. If a card is in
someone else’s name, please include their first and last name
and phone number when asked.

If you'd like to have your AppleLink charges automatically
deducted from your checking account, press Command-3 to
choose CHECKFREE. Then enter your checking account transit
number (the set of nine numbers at the lower left of your check),
your checking account number, and the name and address of
your local branch of that bank. In a few days, you'll receive an
authorization form by mail; please fill out the form, sign it, and
return it promptly.

If the checking account is in someone else’s name, please fill in
that name. If not, leave this box blank. Press Command-1 to
send the information.

If you make a mistake in entering these codes, you may be
disconnected. Please call Customer Service for help.

8. Choose a screen name.

This is the name by which you’ll be known when you're on line.
Making up a screen name protects your privacy, but, like a
Citizen Band radio “handle,” it can also indicate your interests
or your real name.

AppleLink suggests a name. You can accept that by pressing
Command-1 or you can type your own creation in the space,
then press Return. Your screen name must start with a letter,
which will be capitalized automatically. The name must contain
at least three, but no more than ten, letters or numbers. You may
not add any punctuation. If the name you want has already been
taken, AppleLink suggests an alternative.

Decide if you want to be listed in the AppleLink Member
Directory.

1O
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% By the way: After you've finished registering, when you sign on
again, you'll be able to create up to four more screen names for
yourself or your friends or family members. They’ll all be billed
to the same account. See “Adding or Deleting Screen Names” in
“Personalizing Your Screen” in Chapter 3.

AppleLink now asks a series of questions about your background.
This information will be kept strictly confidential. Your answers
help adapt AppleLink to serve you better.

9. Get a confirmation.

When you complete the registration process, AppleLink writes
some of this information down on your disk for future reference.
You are now disconnected from AppleLink, and someone in our
customer service department verifies the information you've
provided, then telephones you to make sure it’s really you
signing up. If your line is free, you'll usually hear from us within
half an hour; certainly within 24 hours.

Once you get that call, you're fully registered and can sign onto
AppleLink at any time.

What next

Sign on and plunge into AppleLink. You'll find that you get plenty of
guidance on the screen, so you won't feel lost. The best way to get to
know AppleLink is to explore. The AppleLink community is so easy
to move around in, you'll feel as if you're visiling a new town,
getting a sense of what each neighborhood is like.

For step-by-step instructions on any particular task you might want
to accomplish, please turn to the next chapter, “Using AppleLink.”
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Chapter 3

Using Applelink

In this chapter, you'll find step-by-step instructions on how to
perform some of the most common activities in AppleLink. The
activities include

O starting up, moving around, and stopping
O communicating and socializing

O participating in events and activities

O learning

O working with pathnames, disks, and files

Most of the time, you'll be able to navigate through AppleLink by
using the prompts and on-line help. Think of this chapter as your
backup, providing a little more detail.

For most activities, you'll see the general topic at the upper-left
corner of every left-hand page in the chapter. Then, in columns
across the two-page spread, you'll see a series of related options.
Pick the one you're interested in and read the instructions and
explanations.

ApplelLink grows and changes every day, so we are not able to cover
every possibility now available to you. But this chapter does
provide you with the basic techniques you need.

27




Signing on and off

To link up with other
members of the AppleLink
community, you need to sign
on.

Once you've set up the
software, as described in the
Connect Guide and in

Chapter 2, the software itself
does the hard work —dialing
to the network, making the
connection, verifying that the
connection is good,
conveying your password to
the AppleLink host computer,
receiving a welcome, and
loading the screen with
choices.

If you chose manual dialing
when you set up your modem,
choose Sign On. You get the
message “You may now enter
your commands.” Use
standard Hayes modem
commands to tell the modem
to activate, search for a dial
tone, and then dial the local
access number. Type
atdt<access number>.
The modem dials AppleLink
and reports the connection.
Press Command-T and then
select the Options menu.
Choose Resume Connecting.

From scratch

If your computer is off, put
your working copy of the
AppleLink program disk in
your main drive, remove all
disks from your other drives,
and turn on the computer,
monitor, and modem.

Choose Sign On.

Use the arrow keys to move
the highlighting, then press
Return; or double-click Sign
On.

If you have set up several
screen names, you're asked to
choose which screen name
you want to use in this
session.

Once you've read the
announcements for the day,
press Return to clear them
away; then highlight either
Apple Community or General
Services and press Return.
You see icons representing
the available departments.

28 Chapter 3: Using Applelink

From another application

Quit the other application.
Remove that disk.

Insert your working copy of
the AppleLink program disk.

Hold down the Command key
(it has an open apple on i),
and while holding that key
down, press Control and
Reset.

Pressing these keys restarts
your computer and launches
the AppleLink software.

Make sure your modem is
connected to your compulter
and turned on.

Choose Sign On.

Use the arrow keys to move
the highlighting, then press
Return; or double-click Sign
On.

Once you've read the
announcements for the day,
press Return to clear them
away; then highlight either
Apple Community or General
Services and press Return.
You see icons representing
the available departments.




1T L L L L T T T 4 24 2 4 A 4,

From working off line in the
Applelink application

Hold down the Command key
(marked with an open apple)
and press Esc to close all
open menus and windows.

Use the arrow keys or the
mouse to highlight the Go To
menu.

Press Return or click the
mouse to open the Go To
menu.

Move the highlighting to Go
to Sign-On Menu and press
Return or click the mouse.

With the icon for Sign On
highlighted, press Return or
click the mouse.

Use the arrow keys to move
the highlighting, then press
Return; or double-click Sign
On.

Once you've read the
announcements for the day,
press Return to clear those
announcements away, then
highlight either Apple
Community or General
Services and press Return.
You see icons representing
the available departments.

If you have trouble

Reset your modem. Make sure
your modem is turned on,
plugged into the electrical
outlet, and connected to the
telephone jack and your
computer.

Turn your computer off, then
start it again.

Choose Set Up on the first
screen you see when you start
up AppleLink and choose Set
Up Phone. Make sure you
have entered the correct local
access phone number for the
network. (See the list of local
access numbers in the
Applelink Connect Guide.)

Choose Set Up Modem and
make sure you have entered
the correct information about
your modem.

Choose Change Slot Setting
from the Set Up menu, then
type in the number of the slot
you’re using for your modem.

If none of this works or you're
just puzzled, make a note of
any “problem number”
indicated on your screen, and
call AppleLink Customer
Service at 1-800-227-6364 for
immediate help.

Signing off

When you're on line, and
want to leave AppleLink, press
Command-Q to quit, then
press Command-2 to confirm
that you're quitting.

Or choose Sign Off from the
File menu.

Please wait until you see the
message “Press RETURN for
Sign On menu” at the bottom
of your screen before you turn
off your computer.

If you were to turn off your
computer without signing off,
your modem might not
recognize that you’d stopped
using AppleLink; the modem
would stay connected to the
network, on its own, and
you'd continue to be charged
until AppleLink disconnected
you.

Signing on and off 29
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Using icons, menus,
and keys

You have a number of ways to
make choices as you move
around in AppleLink.

Sometimes you see a screen
full of icons representing
areas or departments you can
visit. Other times you see a
number of menu titles in a bar
across the top of the screen.
You can open up one of these
menus to peruse the choices
within.

You can navigate through
these choices by using the
keyboard or a mouse.

And as you become more
familiar with AppleLink,
you'll become skilled at using
two kinds of shortcuts—
keystroke combinations, and
Keywords.

Using icons

When you see the icon
representing the area or
department you want 1o visit,
use the arrow keys or the
mouse to highlight that icon.

Press Return or click the
mouse again to choose the
icon.

When you choose the icon for
Set-up, Set Options, or Work
Offline, you see a menu bar
with the titles of several menus
on it.

When you choose the icon for
Sign On, you see icons
representing the Apple
Community or General
Services; and when you
choose one of those, you sce
a screen full of icons
representing departments.
When you choose one of
those departments, you get a
menu bar with the titles of
several menus.

The hourglass icon, blinking
at the bottom of the screen,
means “Please wait while data
gets sent or received.”

Chapter 3: Using Applelink

Using menus and
commands

Close any open windows.
Then use the Right or Left
Arrow key to move along the
menu bar to the title of the
menu you want—or, if you're
using the mouse, click the
menu title once.

To open the menu, press
Return or click the mouse
again.

Use the Up and Down Arrow
keys to move the highlighting
to the item or command you
want or click it.

To choose that highlighted
item or command, press
Return or click the mouse
again.

To close a menu, press Esc,
or click the mouse outside the
menu.

To close all windows and all
menus and return to the menu
bar, press Command-Esc.

If you find you’re in an area
where you don't see a menu
bar, press Command-T to get
the menu bar back.
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Using individual keys

To move forward or backward
among icons, menu titles, or
text characters, use the Right
or Left Arrow key. To move
highlighting up or down in a
menu or list or to scroll text,
use the Up or Down Arrow
key.

To move from box to box or
from field to field within a
window, press Tab.

To cancel an ongoing
activity, press Command-.
(period).

To cancel an activity when
you're done or to escape from
it, press Esc or click outside
the window.

You return to the window or
menu you came from.

To choose a highlighted icon
or title on a list, press Return.

Using Keywords

Using keystroke
combinations

m To zip to another department ® To take a shortcut with some
or area, press Command-K commands, you press the
for Keyword or choose Use Command key at the same
Keyword from the Go To time as a number key, as
menu. indicated at the bottom of the

window. (Or click the little

" Typete ReyreniClave box just to the left of the
place you want to go and press B b i “command)
Return. Any department pprop E
name is a Keyword. m To take a shortcut to
For a current list of Keywords, S S elie o pe o

an on-screen operation,
go to the Apple (%) menu and
choose About Keywords. ity Commarxd i ——
time as a particular letter or
Here are some standard mark of punctuation. (See the
Keywords (with any alternates AppleLink Quick Reference
in parentheses): Card or the list on the next
AppleLink University page.)

S Ditiacky) The same combination of
Ap?;%:ﬁnrim;m SIF) Command and a number may
Applidten d,qua s mean diffe%'ent things in

(Apple, HQ) different windows; the
Calendar and Events combination of Command

(Calendar, Events) with a letter, though, always
Club House means the same thing.

(Clubs)

Customer Service

(Service, Information)
Financial District

(Finance, Business)
Industry Connection

(IC, IND)

Learning Center

(Education, Learming)
News Room

(News)

Recreation Center

(Recreation, Games)
Reference Library

(Reference)

Software Center

(Software Library)
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Keystroke combination
shortcuts

Command-A
Takes you to the Apple
Community

Command-C
Takes you to the People
Connection in General
Services.

Command-F
Lets you send a FlashNote.

Command-G
Takes you to General
Services.

Command-I
Identifies another
AppleLink member whose
screen name you know,
providing a brief profile
on the person.

Command-K
Lets you use a keyword to
zip to another location in
AppleLink.

Command-L
Locates other AppleLink
members, telling you
where they are if they’re on
line.

Command-M
Takes you to the AppleLink
Main Menu, which shows
the icons for the Apple
Community and General
Services.

Command-Q
Lets you sign off, or, if
you're already off line, lets
you quit AppleLink
altogether,

Command-.
Cancels any transfer of
information, such as
incoming text, file
transfers, or the process of
signing on.

Command-Up Arrow
Brings the previous page
of text back into view.

Command-Down Arrow
Moves you to the next page
of text.

Command-Left Arrow
Moves your cursor one
word to the left when
you're editing text.

Command-Right Arrow
Moves your cursor one
word to the right when
you're editing text.
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Command-?
Gives you general
information about the
department or area you're
in.

Command-Esc
Closes all open windows
and menus, letting you
escape, and returning you
to the menu bar.

Command-=
Lets you choose Set
Options.

Control-X
Clears all text in a field.

Control-Y
Clears all text from the
insertion point to the end
of the field.

Control-L
Moves the insertion point
to the beginning of a line.

Control-R
Moves the insertion point
to the end of a line.
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Getting assistance
with your account

Customer Service is the place
to perform transactions and
ask questions about your
account. You can check your
current or previous month’s
bill, update billing and
account information and find
complete explanations of our
billing structure and
procedures.

If you need to communicate
with us about your account,
you can post a private
message.

In an emergency or if you
can’t find the information
you’re looking for in the on-
line Customer Service
department, you can talk to a
Customer Service
representative by calling
1-800-227-6364.

About your bill

From the General Services
menu, choose Customer
Service.

Choose Billing Information
and follow the instructions in
the dialog box.

You can now check your
current bill and last month’s
bill; you can read about the
way the bill is made up and, if
you want, you can change
your method of payment. If
you'd like, you can also post a
private message about your
bill.

You can reach Customer
Service with a Keyword, too.
From anywhere in AppleLink,
press Command-K for
Keyword or choose Use
Keyword from the Go To
menu. Then type Service and
press Return.

About your account

From the General Services
menu, choose Customer
Service.

Choose Billing Information.

You can now change your
address and any other
information about your
account by following the
instructions in the dialog box.

For information about the
general terms of service,
press Esc to return to the
Customer Service menu and
choose Terms of Service.
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Getting help

AppleLink has been designed
to provide you with lots of
help.

At the bottom of most
windows you'll find a list of
commands and keystroke
combinations, indicating
what you can do next.

The Apple (%) menu, always

accessible in a few keystrokes,
offers information about any
of the departments shown on
the current menu bar.

And in General Services, the
Customer Service menu
provides a Members’ Online
Guide, with detailed advice
on how to do almost
anything.

If you have looked through
this manual, used all the
on-line help, and are still
having problems, call the
AppleLink Customer Service
number, 1-800-227-6364.

On what to do next

Look at the bottom of the
window.

You see buttons to click,
followed by a keystroke
combination, the name of the
command, and any
alternative key that would
bring the same result.

m Follow the directions.

Chapter 3: Using Applelink

About the contents
of a department

m With the department’s name

showing in the menu bar,
move the highlighting to the
Apple (%) menu, then press
Return or click the mouse.

Choose “About” the
department you want to know
about.

When you have entered a
department and you want to
show more about it, press
Command-?.

To see a screen full of
available departments, press
Command-M to go back to
the Main Menu, then choose
either Apple Community or
General Services. To get a
menu bar, just choose any
department shown.

0 0 0
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On how to do it

Go to General Services.

From anywhere on line, press
Command-G.

Choose Customer Service.

From the Customer Service
menu, choose Members’
Online Guide.

Choose the topic you want to
know more about.

Use the Up or Down Arrow key
to highlight the topic, then
press Return; or just
double-click the topic.

The Members’ Online Guide
gives you step-by-step advice
on how to download and
upload software, how to order
products, how to use
pathnames and screen
names, and how to
participate in many other
activities.

In depth—on paper

For step-by-step advice on
how to do most tasks, use this
chapter.

Every left-hand page starts
with the name of a major task.
Across the two-page spread,
you see individual columns
devoted to subtasks or options
within that general area. In
each column, you get
instructions and
explanations.

Right away—by phone

If you have looked through
this book and through the
on-line help and are still
having problems or if you
need immediate attention,
please call AppleLink
Customer Service at
1-800-227-6364.

Customer Service
representatives will talk you
through the steps you need to
take.
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Personalizing your
screen

You can make a few
adjustments to the way
information appears on your
screen in AppleLink.

You can have the
conversation in a chat room
appear in single- or double-
spaced lines.

You can have a menu fall
down automatically as soon as
you choose a department, or
you can have it stay up until
you press Return or click
again.

You can have AppleLink take
you directly to a particular
department whenever you
sign on.

And you can create an
additional four screen names
for yourself and your family,
adding or deleting them at
will. (You can't change or
delete your original screen
name, though.)

Spacing in chat rooms

If you're already on line, go to
Customer Service in General
Services, choose Personalize
Applelink, and then Change
Options. You see a dialog
box, in which you can choose
single or double spacing,
Press Command-2 to save the
setting.

If you're off line, follow these
steps:

From the Sign On menu,
choose Set Options.

In the window, use the arrow
keys to move the highlighting
to either single or double
spacing.

Press Command-2 to save this
setting to disk.

Chapter 3: Using Applelink

Menus down or up
when you enter an area

If you are on line, go to
General Services. Choose
Customer Service, then
choose Personalize
AppleLink. From that menu,
choose Change Options. In
the dialog box, choose Auto
Menu On to have menus open
automatically; choose Auto
Menu Off to keep that from
happening. Press
Command-2 to save the
setting.

If you're off line, follow these
steps:

From the Sign On menu,
choose Set Options.

In the window, use the arrow
keys to move the highlighting
to either off or on.

Off means that when you
highlight the title of the
menu, it will not
automatically drop down. On
means it will.

Press Command-2 to save this
setting to disk.
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Adding or deleting
screen names

While on line, press
Command-G for General
Services.

Choose Customer Service.

Choose Personalize
AppleLink.

Choose Create/Delete Screen
Names and follow instructions
in the dialog box.

Press Command-2 to save this
information to disk.

You choose your primary
screen name during the
registration process, as
described in Chapter 2.

Setting an Initial
department

In General Services, choose
Customer Service.

Choose Personalize
Applelink.

Choose Set Initial
Department.

In the dialog box, enter the
Keyword for the department
you'd like to go to as soon as
you sign onto AppleLink.

For a list of current Keywords,
press Command-3. Choose
Department Keywords,
Forum Keywords, or Industry
Connection Keywords from
the list.

Personalizing your screen
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Quitting, stopping,
and escaping

You can always get out! No
matter how many menus
you've opened, no matter
how deep you’ve gotten into a
subject, you can leave a
window, an area, or
AppleLink in just a few
keystrokes.

To close a window

Press Esc to close the window.

If you're in a chat room
without a menu bar, press
Command-T to bring back
the menu bar, then use the Go
To menu to leave the chat
room.

If the open window contains
more than a full screen of
text, you may have to wait for
the hourglass symbol to go
away before escaping,

Press Command-. (period) to
stop data transmission in
progress.

Chapter 3: Using Applelink

To close every open
window and menu

Press Command-Esc.

The open windows and menus
vanish, leaving you back at
the menu bar you came from.

||
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To stop an operation

B Press Command-. (period) to
stop any data transmission,
such as sending a file or
downloading.

To sign off

Press Command-Q to quit,
then press Command-2 to
confirm that you really do
want to leave the network.

Or choose Sign Off from the
File menu and press
Command-2 to confirm.

A message tells you to wait
while the modem hangs up.
Another message appears,
saying “Press Return for Sign
On menu.” To sign back on,
press Return.

To quit ApplelLink

If you are on line, sign off,
press Command-Q then press
Command-2 to confirm that
you want to leave AppleLink.

When you are working off
line, press Command-Q or
choose Quit from the Go To
menu,

You leave AppleLink and go
back to the ProDOS®
operating system.

Before quitting, make sure
that you save any important
files you've been working on.

Quitting, stopping, and escaping 39
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General typing
and editing

To write

Within AppleLink, you can
create memos, FlashNotes,
messages 1o post on message
boards, mail and responses
to mail, and bits and pieces of
conversation during a chat.
All this talk involves typing.

m Type whatever you have in
mind.

You don’t have to type
everything correctly. The
point is to get your ideas
across. But if you want to
polish up a phrase or two, you
can do a little editing. Here's
how.

Chapter 3: Using Applelink

You can revise it as you go.

To delete a character

Use the arrow keys or the
mouse to move the cursor to
the character just to the right
of the character you want to
delete, or click there.

Press Backspace to delete the
unwanted character.

And go on Backspacing as
long as you want.
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To insert characters

Type away.

Each character appears to the
left of the cursor as it moves
on.

If you've already typed a
passage and now want to
insert a character or two,
move the cursor under
whatever character you want
to end up just to the right of
the ones you’re about to
insert. Then type.

The cursor pushes whatever
character lies above it out of
the way, to the right.

To move left and right,
up and down through text

In general, use the arrow keys
or click where you want to
work.

To move one word to the left,
press Command-Left Arrow.

To move one word to the
right, press Command-Right
Arrow.

® To move the insertion point

to the beginning of a line,
press Control-L.

® To move the insertion point

to the end of a line, press
Control-R.

To clear text in a field

To clear all the text in a field,
press Control-X.

A field is a box in which
you're invited to write
something such as a screen
name or a Keyword.

To clear all the text from the
insertion point to the end of
the field, press Control-Y.

To move from one field to the
next, press Tab.
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Receiving your mail

If you have mail waiting for
you when you sign onto
AppleLink, the mailbox flag
pops up. If someone sends
you mail while you're in a
department, the word MAIL
shows up in a corner of the
screen.

To collect your mail, you
need to go to the Post Office.
There are branches in every
on-line department; on the
menu bar, you'll find a menu
named Post Office. And this
Post Office is open 24 hours a
day.

The Post Office holds any
piece of unread mail for 8
weeks. After you've read a
piece of mail, the Post Office
retains it for you for a week,
just in case you want to come
back and reread it or get a
copy to save on disk. So if you
think you’re going to need to
refer to a piece of mail again,
be sure to save it.

You don't have to do
anything special to receive a
FlashNote; it just appears on
your screen while you're on
line—as long as you are not
currently receiving a file. A
FlashNote is momentary: You
cannot save it.

To read your mail

From any Apple Community
or General Services
department, choose Read
Incoming Mail from the Post
Office menu.

If you have unread mail
waiting for you, you see a list
of the items.

Highlight the item you want to
read first and press Return.

Read away.

If all the text isn't visible,
press the Down Arrow key. To
move a whole page at a time,
press Command-Down
Arrow or Command-Up
Arrow.

With one message open on
the screen, press
Command-4 to see the next
message.

If the message you want to see
isn’t the next on the list, you
need to cancel the message
that’s currently being
displayed on your screen.
That takes you back to the list.
Choose the other message.

If you've been sent a file, you
need to download and save it
for now and use that file’s
application to open it

Chapter 3: Using AppleLink

To save or print mail

With the mail before you on
screen, press Command-5.

Enter the ProDOS pathname
leading to the particular disk
you want to save this message
on, and any subvolumes or
subdirectories you want to
store the message in.
Complete the pathname by
giving the mail a filename of
its own. Then press Return.

A pathname begins with a
slash followed by the disk or
volume name, another slash
and any subvolume or
subdirectory, and another
slash, followed by the
filename.

A ProDOS filename must
begin with a letter; it can
contain up to 15 letters,
numbers, and periods—but
no spaces and no other
punctuation,

To print mail you have saved,
sign off AppleLink, return to
the Sign On menu, and
choose Work Offline. On the
File menu, choose Print Text
File; then supply the
pathname leading to your
file.
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To respond to mail
immediately

Open the mail you want to
respond to.

Press Tab to move to the field
in which you can write your
reply.

Write it.

Press Command-2 to send
your response to the author.
Press Command-3 to send the
message to everyone who
received the message.

Your response goes out with
your screen name at the top.

To respond to only a few of
these people, you need to
make up a new letter and
address it directly to them.
See “Sending FlashNotes,
Files, and Mail” later in this
chapter.

To download and print
afile

With the file’s name
highlighted, press
Command-3 to download it
to your current disk and
directory.

You see a dialog box showing
the name of the file you
selected.

m If you want to save the file to

the current disk and
directory, press Return.
AppleLink estimates the time
it will take to download, then
asks for confirmation.

Press Return to confirm that

you want the file downloaded.

To print the file you've
received and saved, use the
application it was created in.

To look at mail
you've already read

From any department, go to
the Post Office and choose
Read Incoming Mail.

Press Command-2 to read old
mail.

Choose the item you want to
reread.

You can also save this old
mail on disk (press
Command-4), read the next
item (Command-3), or
cancel (Command-1).

Incoming Mail (press TAB to answer):

Subj: Chat with you at eight
To: Peneloped

Penelope,

Thanks for your help last night. I've tried your suggestions

89-03-09 18:15:00 EDT
From: Eumolpus

&4 Read Next

&1 Cancel (ESC) O <2 Answer to Author [ &3 fAnswer to All
[ 5 Save fs...
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Sending FlashNotes,
files, and mail

When you'’re on line, you can
send instant messages, called
FlashNotes, from the Post
Office to anyone else who's
currently on line. FlashNotes
are brief, private messages to
a particular person who's
currently on line. That person
gets the message

immediately.

For less pressing matters, you
can leave mail at the Post
Office for people to pick up
when they sign on. Mail is
more permanent: You can
create and save a message of
approximately 4800
characters—about 1000 words
or four double-spaced
pages—and you can send the
message at any time, whether
or not the recipients are on
line. They can read it
whenever they like. You and
the recipient can both save
the mail.

You can send one piece of
mail to up to 16 members,
including the people who are
getting carbon copies. If you
enter more names than the
dialog box can hold, the
names will scroll out of the
box to make room.

The Post Office menu appears
on the menu bar in every
department.

To send an instant
FlashNote to someone
who is on line

From any Apple Community
or General Services
department, choose Send
FlashNote from the Post
Office menu. Or, from almost
anywhere in AppleLink, press
Command-F for FlashNote.

Type in the recipient’s screen
name and press Return.

If this person is not on line
right now, you get a message
to that effect. (If you still want
to send a message—but one
not delivered instantly—
cancel and choose Send Mail
from the Post Office menu.)

Type your message.

Press Command-2 to send the
FlashNote.

The message appears with a
beep on the screen of the
person you sent it to. Your
screen name appears, 0o, SO
the recipient knows whom the
FlashNote is from.

If you want to find out whether
someone’s on line to see if
you can send that person a
FlashNote, choose Locate
Someone from the Post Office
menu or press Command-L.
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To send mail

From any Apple Community
or General Services
department, choose Send
Mail from the Post Office
menu.

Type the screen names of the
recipients, separated by
commas, like this:

Memberl, Member2

If you want to send carbon
copies to some other people,
continue the list of recipients
by entering these names in
parentheses, again separated
by commas but no spaces,
like this:

(Member3, Member4)

Press Tab to go to the subject
field; enter a brief description
of your message.

Press Tab and type your
message.

If you want to add the
complete text of a particular
file, position your cursor
where you want that text to
begin, then press
Command-3, and give the
pathname leading to that file.
If AppleLink can read the file,
the entire text appears in your
message. (Applelink can read
any ASCII file.)




1L L

To send your message, press
Command-2.

Press Tab to move to the
subject box; enter a brief
description of the file you are
sending.

Press Tab to move to the File
field.

To save your message, press
Command-4.

To send a file
to another member

From the Post Office menu,
choose Send File via Mail.

Type the screen name of the
person you're sending this file
to.

If you’re sending the file to
several people, separate their
screen names with commas,
like this:

(Member2, Member3)

Type the pathname leading to
the file you want to transfer.

If you don't recall the name of
the disk you want to pull the
file from, cancel, go to the
File menu, and choose List
Volumes.

If you don't recall the name of
the file, go to the File menu
and choose Show Catalog.

If you want to add a comment
about the file, press Tab to
move to the Comments field,
then type in your message.

When you're ready to send
the file, press Command-2.

You now see an indication of
the progress of transferring
the file—and a message
announcing successful
completion.

Sending FlashNotes, files, and mail

To check on mail
you’ve already sent

From the Post Office menu,
choose Check Outgoing Mail.

To see who has read mail you
sent (and when), highlight the
item on the list of mail you've
already sent and then press
Command-2.

To reread the item, highlight
it and then press Return.

You can then save this old
mail on disk (press
Command-4), read the next
piece of mail (Command-3),
or cancel (Command-1).
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Using message
boards

Throughout AppleLink, you'll
find the electronic equivalent
of bulletin boards—message
boards such as Let’s Discuss,
gRaFflti, and the Classifieds,
where you can post your
ideas, opinions, and advice
and read what other people
have to say.

Most boards are devoted to a
particular topic, usually one

that a lot of members want to
exchange messages about.

Message boards go by a lot of
different names (such as As
the Worm Squirms in the
People Connection). You can
tell you're in a message board
when you open a window
showing a list of folders with
an indication of the number
of messages inside each one
and the dates of the first and
the last message. You also see
instructions for listing folders’
contents, opening a message,
and creating new folders.

To enter a message
board

Choose the message board
from the menu of a
department or forum.

You see a list of the folders in
that area, with an indication
of the number of messages
inside, plus the dates of the
first and the last message. You
can see which folder has the
most discussion or
controversy, which is the
most current, and which topic
you want to explore.

To open a folder

Highlight the folder in the
list.

(A folder is a subvolume or
subdirectory, containing a
number of messages.)

To see a list of the folder’s
contents, press Return or
Command-3.

To see a list of any contents
that have shown up since you
last looked in this folder,
press Command-4.

To open the first message,
press Command-5.

Folders in Apple Development Forum Business:

i Suggested at” buests
Expanding Code Debate
Let's Introduce Ourselves
Software Library Help

Suggestion Box
Forum Marquee

HHHHHEHE,

AppleFest Standards Conference

Forum Questions and Answers

1a/08-00/ 1
7 04/17-05/12
13 04/06-05/08
35 12/15-06/06
8 12/02-05/31
8 12/02-05/0%
312/02-04726
2 12/02-05/26

O &1 Cancel (ESD)
[ &3 List Contents ()
[ &35 Open First Messoge

2 Create Folder
Y List New Contents
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To read a message

While looking at the list of
folders, highlight a folder title
and press Command-5 to
read the first message.

Or highlight a folder title,
press Command-2 to open it,
highlight the exact message
you want to read or work with,
and press Return.

Once the message is on the
screen before you, you can go
on to read the next message
by pressing Command-2.

To go back to the previous
message, press Command-3.

To save the message that's
now on-screen, press
Command-4. Then assign the
message a pathname.

To create your own folder

While you have the list of
folders on the screen, press
Command-2.

To post your own
message

To add your own message to
the folder, press
Command-5. Type in your
subject, press Tab, and type

Enter the subject, then press
Tab, and enter the text of the
first message for your new
folder.

your message. Then press

You can use the text of
another file as part of that
message—ijust press
Command-3 and give the
pathname leading to the file.

If your message is really
inspiring, you can save it on
disk by pressing Command-4.

And finally, you can post your
message (in its own folder) on
the message board by
pressing Command-2.

Command-2 to dispatch it

88-09-26 14:34:17 EDT
Msgs: 361 (B9-06-06)

Subj: Let's Introduce Ourselves
From: SYSOP

Welcome to the Apple II development Forum! Please toke a moment
to tell everyone a little about yourself and your interests. This
1i:s. also the place to find out about the other members of this
orum.

B &1 Cancel (ESD)
B &3 Read Previous Messoge
B &5 Add Message

[ &2 Read Hext Message
[ &Y Save fs...

Using message boards
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Chatting

Throughout AppleLink, you'll
find rooms in which you can
chat with other people on
line. You can walk in, listen to
the conversation, then join in
or leave.

Chat rooms appear
throughout AppleLink. Some
of these rooms can be found
in the People Connection,
Industry Connection, Student
Union at the University of
Tomorrow, the Apple Cafe at
Apple Headquarters, and
many forums.

To enter a chat room

Choose the chat room on a
department menu.

Or choose People
Connection in General
Services.

In the upper-left corner of
your screen, you see the name
of the room. Below it, on the
line marked /3, you see your
name and the names of other
recent arrivals. As people
arrive, their screen names
appear at the beginning of the
line.

The line below Hi, marked
Bye, shows the names of those
who have recently left.

Hi: Eumolpus, Peneloped, BillP
Bye: Tithoneus
P ;T FOR MENU

Tithoneus There are some great programs and smart people there. brb
Peneloped Do you upload files or information yourself?

BillP Sometimes, usually just read other people's information. ;)
BillP Have you enrolled in any AppleLink University claosses?
Peneloped Not yet. Are there some good ones?

BillP They've got some great ones-programming in Basic, Appleblorks
BillP Lots of Rpplellorks support therel

Eumolpus Hi, Penelopel Thanks for your help last nightl]
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To contribute
to the conversation

Type away.

What you type appears in the
line at the bottom of the
screen. You can edit your
comment by using the arrow
keys and the Delete key.

To send your comment, press
Return.

To bring back the menu, press
Command-T. If you see a
menu at the top of the chat
screen and want to chat, press
Command-T again.

To communicate moods and
reactions that can’t be seen,
people have developed a
visual shorthand you may
want to use. For example:

To show you’re smiling :)
To frown : (
To wink ;)

For a guide to visual
shorthand, see the gRaFfItl
area in the People
Connection.
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To pick people
out of the crowd

If you don’t see a menu bar
across the top of your screen,
press Command-T to display
it.

Choose People from the
menu bar.

To make one person’s
messages stand out from the
ongoing conversation,
choose Highlight Someone
from the People menu. Then
type that person’s screen
name in the dialog box and
press Return. (To cancel this,
choose Remove
Highlighting.)

To keep someone’s messages
from appearing on the
screen, choose Ignore
Someone from the People
menu. Then type that
person’s screen name in the
dialog box and press Return.
(To cancel this, choose Stop
Ignoring.)

To find out who is in the chat
room, choose List People in
this Room.

To find out a litle about
someone, press Command-I
or choose Identify Someone
from the Post Office menu
and type the screen name.

To save a chat on disk

If you are in a chat room,
leave the conversation for a
moment by pressing
Command-T. You return to
the menu bar.

From the File menu, choose
Open Log File.

AppleLink will keep a log of
the conversation—but it won't
include any FlashNotes that
pop up or banner headlines
that move across the screen
during the chat.

Give the pathname leading to
the disk, subdirectory, and
filename you want to use.

Return to the chat room and
chat away. To bring back the
menu, press Command-T. If
you see a menu at the top of
the chat screen and want to
chat, press Command-T
again.

AppleLink now saves whatever
comes across your screen
until you go to the File menu
and choose Close Log File.

To leave the chat room

Use a Command-letter
combination or a Keyword to
go somewhere else directly
from the chat room.

To display the menu bar,
press Command-T.

You can navigate in the usual
way.
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Meeting people

People go to the Lobby of the
People Connection to meet
people. You can join the
general hubbub of
conversation there or enter a
public room for some
scheduled event.

If you want to pick someone
out from the crowd, you can
highlight the person’s
remarks. You can also ignore
someone by telling AppleLink
not to display the person’s
messages.

Once you've made some
friends in the Lobby, you can
create an electronic private
room to continue the
discussion.

You can also meet people in
informal chat rooms
throughout AppleLink. These
rooms may not have other
public and private rooms
available. In all other ways,
they work just like the People
Connection.

If you're talking with one other
person and find one line at a
time too limiting, consider
exchanging FlashNotes.

To enter the lobby—
and exit

If you've just signed on,
choose General Services.
From the General Services
menu, choose People
Connection.

From anywhere in AppleLink,
press Command-C to go
directly to the People
Connection.

You're now in the People
Connection Lobby.

When you want to leave the
Lobby, press Command-T to
display the People
Connection menu bar. Then
choose Go To.

The Go To menu lets you
enter a different room or
leave the People Connection
and go to another area of
AppleLink. You can also leave
by using a Keyword or a
keystroke combination.
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To join the conversation

Type your message.

As you type, your message
appears on the bar at the
bottom of the screen. If you
type more characters than
can fit on a line, your
computer beeps.

Press Return to send your
message.

Your message moves into the
main area of the screen,
below the last line of
conversation. The bar is
blank, ready for you to type
what you want to say next.

Whenever you want to use the
People Connection menu,
press Command-T to show it.
Press Command-T again
when you want to rejoin the
conversation.

If you are unfamiliar with chat —
rooms, you may want to refer

to “Chatting,” earlier in this

chapter.




To locate or identify
someone

m If you don’t see a menu bar
across the top of your screen,

m Choose Post Office from the
menu bar.

® To learn information about
someone, such as that
person’s home town, choose
Identify Someone, then type
the person’s screen name in
the dialog box and press
Return.

m To see where someone is, if
on line, choose Locate
Someone, then type the
person’s screen name in the
dialog box and press Return.

m If you want to know who is in
the room, choose List People
in this Room from the People
menu.

AppleLink shows you a
window listing the screen
names of everyone in the
Lobby.

m To rejoin the conversation
after using the menu bar,
return to the chat room and
press Command-T.
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press Command-T to show it.

To go to a public room

m If necessary, press ]
Command-T to display the
the menu bar. Then choose
Go To.

m Choose Go to Public Room. [}

m If you don't know which public m
rooms are in use, choose List
Public Rooms to see a list.

You may find activities in
progress in a variety of public
rooms.

® Type the name of the room in
the dialog box and press
Return.

The name of the room at the
upper-left corner of your
screen shows your new
location.

m To leave a public room, use
the Go To menu.

To go to a private room

If necessary, press
Command-T to display the
the menu bar. Then choose
Go To.

Choose Go to Private Room.

Type the name of the room in
the dialog box and press
Return.

Private rooms aren't listed.
They’'re temporary chat
rooms that any member can
create for personal
conversations. You can join
someone in a private room by
typing the name of a room
that already exists, or you can
create a new private room
with any new name you
specify.

You can create as many
private rooms as you like. Just
be sure to tell your friends
where to join you. They need
to know the exact name, For
complete privacy, use a
FlashNote to tell them where
to visit you.

Enter screen name of member to
locate:

Eumolpus_

B &1 Cancel (ESC) @ %2 Locate ()
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Finding out about
events

Calendar and Events is the
place to learn what's
happening in AppleLink. You
can find up-to-the-minute
listings of today’s events, new
offerings, and a complete
calendar for the coming
weeks.

You can find Calendar and
Events in both the Apple
Community menu and the
Customer Service area of
General Services. Both
contain the same listings.

Calendar and Events tells you
what’s happening throughout
AppleLink. You can also find
schedules in many AppleLink
areas.

You can save a schedule of

events on a disk so you can

print it out and then browse
through it at your leisure or
mark the events you want to
attend.

You can also check your
monthly AppleLink Update
magazine for a list of
scheduled events.

To find Calendar
and Events

In the Apple Community
menu, move the highlight to
Calendar and Events and
press Return.

From anywhere in AppleLink,
press Command-K for
Keyword or choose Use
Keyword from the Go To
menu. Then type Calendar
or Events and press Return,

In the General Services menu,
move the highlight to
Customer Service and press
Return.

The Customer Service menu
includes the same calendar
items as Calendar and
Events—plus some additional
services.
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To learn about current
events

m Choose Best Bets from the
menu.

m Scroll through the list of
events that will take place
today or this weekend.
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To check for hot tips

Choose Don’t Miss from the
Customer Service menu.

These are special notices,
recent additions to the
schedule, and events we're
especially proud to bring you.

To check the calendar

Choose Schedule of Events.

You see a submenu of dates,
grouped into weeks.

m Choose a week from the list.

You see a window in which
events are listed by date,

along with a brief description.

Scroll through the list.

Finding out about events

To save a listing

Display on the screen the
schedule you want to save.

Put a formatted disk in your
disk drive.

Press Command-2 to save the
information on the screen.

If nothing happens, you may
need to wait until the
hourglass symbol disappears
before the command
becomes active. AppleLink
will save the entire schedule
you chose.

Type a pathname for the file
in the dialog box and press
Return.

While AppleLink saves the
file, a gauge shows you how
much of the task is complete.




Attending a forum

Join an Apple Forum to learn
more about Apple products
and compatible hardware and
software products.

Or attend an Industry
Connection forum to learn
about products developed by
other companies for your
Apple computer.

The forums combine several
AppleLink features to explore
the Apple computer
world—regular meetings in
the forum chat room, special
events in the conference hall,
software libraries, product
support boards, and message
boards for exchanging tips,
information, questions, and
answers—all coordinated by
our knowledgeable staff of
forum leaders.

To find the Apple forums

If you've just signed on,
choose Apple Community
from the AppleLink Main
Menu. Then choose Apple
Forum or Industry
Connection from the Apple
Community menu,

From anywhere in AppleLink,
press Command-K for
Keyword or choose Use
Keyword from the Go To
menu. Then type Forums or
IC and press Return,

m To see descriptions of the

subjects addressed in each
group of forums, as well as
general information about
how the forums work, choose
About the Forums from the
Forums menu.
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To browse the forum
topics

In the Forums menu, choose a
subject area, for example,
Apple 1I Forums. You'll see a
menu of subtopics.

If necessary, choose from a
series of submenus listing
more specific topics until you
locate a specific forum. Just
follow your nose. You can
always use Command-1 to
back out the way you came.

When you see a forum that
interests you, choose it.

AppleLink shows you a list
from which you can choose to
see information about the
topic, forum leader, and
meeting time. Your forum
leader can give you lots of
support in his or her
specialty.

You can also choose the
forum chat room, the
software library, and the
message board, often named
Let’s Discuss.
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To browse the schedule

From the Forums menu,
choose Tonight (or This
Weekend) in the Forums.

You see a list from which you
can choose current events,
upcoming conferences, or
the full calendar for the
coming weeks.

Choose an item that interests
you.

If you chose the calendar,
choose the week you want
from the list of dates.

Scroll through the events to
read about the topic,
instructor, time, and place.

To participate
in a forum meeting

Choose the major subject
area from the Forums menu.

Choose the forum you want to
attend.

® Choose Chat Room.

If you are unfamiliar with chat
rooms, you may want to read
the instructions in

“Chatting,” earlier in this
chapter.

You can also go directly to a
specific Apple Forum from
anywhere in AppleLink by
using a Keyword. For a list of
Keywords, choose Use
Keyword from the Go To
menu and then press
Command-3.

To see the log
of a meeting

To go to the Reference
Library, press Command-K
for Keyword, type
Reference, and press
Return.

From the Reference Library
menu, choose Apple
Archives.

From the list of forum
subjects, choose a forum.

You see a list of files. Each
contains the log of a forum
meeting.

Highlight the file you want
and then follow the directions
on the screen.

You can read the leader’s
description of the forum, see
any additional comments on
the meeting, and save and
print the log of the forum
meeting.
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Attending an event
in an auditorium

You can attend a speech,
panel discussion, or other
special event in an
auditorium, an area devoted
to scheduled events. Special
procedures for asking
questions make the
auditorium ideal for lectures
and other large events.

Afterward, you can geta
complete transcript of the
event from the Apple
Archives.

Want to visit a typical
auditorium? Go to the People
Connection in General
Services and press
Command-T to see the menu.
From the menu, choose
Auditorium.

To ask a question

To relay a question to the
special event’s host or guest,
press Command-T to see the
Auditorium menu bar.

Choose Auditorium to open
the Auditorium menu.

Choose Ask a Question.

Type your question in the
dialog box and press
Command-2 to send it to the
“podium.”

Your question automatically
enters a queue. The event
leader can read it and
publicly display it during the
course of the event.
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To leave an auditorium

m If the menu bar isn’t showing

on your screen, press
Command-T to display it.

m Choose the Go To menu.

The Go To menu can take you
anywhere in AppleLink.



To see a transcript

® From the Reference Library
menu, choose Apple
Archives.

You see a list of files.

m Highlight the file you want
and follow the directions in
the dialog box.

You can look at comments
about the event and a
description of the file; then if
you want, you can save the file
on a disk.
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Looking up
information

There are a number of places
on line, such as Grolier’s
Academic American
Encyclopedia and the
Reference Library, where you
can look up information.

To find what you're looking
for in any of the AppleLink
resources, you perform what’s
called a search. Instead of
choosing from a list of topics
or scrolling through a list of
articles, you tell AppleLink
what to look for by supplying
words to describe the subject
that interests you. Then,
based on what AppleLink
comes up with, you refine
your instructions until you
find just what you want.

Experimenting is the best way
to get the knack of searching.
So go ahead and explore.
Interesting surprises are
always in store—references
you never knew existed,
perhaps some more
intriguing than the subject you
started out to find.

To start a search

When you see the dialog box
asking you to type in your
search words, type the word
or phrase that best describes
the information you seek.

Press Command-2 to tell
AppleLink to search the
library.

AppleLink displays a list of
items that contain the words
you entered. Or AppleLink
displays a message telling you
that it found no articles or too
many to list; you need to
widen or narrow your search.

m To use the Grolier

encyclopedia, choose the
Learning Center from the
General Services menu. Then
choose Academic American
Encyclopedia from the
Learning Center menu.
Choose Encyclopedia
Articles from the
Encyclopedia menu.

m To use the Reference Library,

choose it from the Apple
Community menu. On the
list, choose the subject you'’re
interested in. Depending on
the subject area, you may
need to choose from a second
submenu.

Type the word or words you want to search for:

Apple II AND Imageliriter

B &1 Cancel (ESC)

B &2 Search ()
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To widen a search

If AppleLink didn’t locate
enough references to find
what you’re looking for, try
typing related words and
connecting them with OR.

When you type Network OR
Lan OR AppleTalk,
AppleLink assumes you’re
interested in information
about any or all of the terms.
AppleLink then looks for
references that include at least
one of the terms, whether or
not the others are present.

To narrow a search

If AppleLink found too many
references, narrow the focus
by connecting words with
AND.

Typing Apple II AND
ImageWriter requests only
those items that contain both
terms. This way you exclude
any article that mentions only
the Apple II or only the
ImageWriter.

m To exclude specific items, use

the word NOT.

Typing Data Base AND
Biology NOT School
requeslts references
concerning biology
databases, but not including
school uses. That eliminates
some references.

Try using more specific
terms.

For example, instead of
Troubleshooting, type
Apple IIe and Error
and Disk Drive.

To view and save
an article

To view an article that
AppleLink has listed, select it
and press Return,

If you want to save the article
on disk, follow the directions
on the screen.

Once you have saved the
article, you can print it out
when you are off line. You use
the Print Text File command
in the File menu or a word
processing application.
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Learning on Applelink

AppleLink University offers a
spectrum of courses designed
to let you unlock the full
potential of your Apple
computer. Classes extend
your computer skills and show
you how your computer can
work for you in the real world.

The University of Tomorrow
offers real-time courses
during evenings and
weekends. You attend classes,
participate in discussions with
teachers and other students,
download study materials and
software, and check your
progress—all from the
keyboard.

Innovative course formats let
you work at your own pace.
You read the lessons,
download study materials,
work off line at your
computer, and still enjoy the
opportunity for real-time
interaction with faculty and
students.

You'll find other courses, and
tutoring, at areas such as the
Learning Center in General
Services.

To find a school

To go to the AppleLink
University, choose University
from the Apple Community
menu.

To go to the Learning Center,
choose it from the General
Services menu.

To go to the University of
Tomorrow, choose it from
the Learning Center menu.

You can also use Keywords.
From anywhere in AppleLink,
press Command-K for
Keyword or choose Use
Keyword from the Go To
menu. For AppleLink
University, type AU or
University and press
Return. For the Learning
Center, type Education or

Learning and press Return.
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To learn about a particular
course

From the Apple University
menu, choose
Administration, then choose
Course Descriptions. Choose
the course you want to know
more about.

From the University of
Tomorrow menu, choose
Departments/Classrooms,
choose a department you're
interested in, then choose
Course Description.

You see a description of the
course, including
information such as what you
will learn, how you will do the
work, how long it will take,
what software or materials
you'll need, and whom the
course is for.
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To enroll or register

From the Apple University
menu, choose
Administration, then choose
Enrollment for the course you
want to take.

From the University of
Tomorrow menu, choose
Registration.

Follow the instructions on the
screen. You'll be asked for
some information, such as
your screen name, mailing
address, and type of
computer.

To attend class

From the AppleLink
University menu, choose
Classrooms, then choose the
one you want.

From the University of
Tomorrow menu, choose
Departments/Classrooms,
then choose Classroom, then
choose Enter Classroom, and
pick the one you want.

Learning on Applelink
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Getting help
with studies

The Learning Center offers
tutoring nightly and on
weekends. You can join
regularly scheduled tutoring
sessions or communicate
privately with a tutor to
arrange a one-to-one
session.

The Tutoring Center also has
message boards to post
questions and receive
answers, department libraries
from which you can download
study materials, and courses
targeted at specific age groups
and educational levels.

To find the Tutoring Center

If you're just signing on,
choose General Services from
the Applelink Main Menu.
Then choose Learning Center
from the General Services
menu.

If you're already somewhere
in AppleLink, press
Command-K for Keyword or
choose Use Keyword from the
Go To menu and then type
Education or Learning
and press Return.

You see the Learning Center
menu bar.

From the Learning Center
menu, choose Tutoring
Center.

Chapter 3: Using Applelink

To learn about tutoring

If you're new to the Tutoring
Center and want some general
information, choose About
the Tutoring Center from the
Tutoring Center menu.

Return to the Tutoring Center
menu and choose the
department you're interested
in.

Within the department,
choose Information. Here
you can read about tutoring in
the particular subject you want
help with.
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To attend a tutoring
session

Choose Monthly Schedule
from the Tutoring Center
menu to check the meeting
times and place for the
session you want.

Choose Classrooms from the
Tutoring Center menu.

If you're unsure how to
participate, choose
Classroom Procedures.

The classroom is a chat
room, with some special rules
to make discussions more
productive. Here, you can
read about protocol for
classroom discussions.

From the Classrooms menu,
choose the classroom where
your session is held.

To communicate with the
tutor between sessions

To post a message to the tutor
on the department message
board, choose Message
Board from the Department
menu.

If you're unsure how to post a
message, refer to “Using
Message Boards,” earlier in
this chapter. Your tutor will
post an answer for you.

To send a private message, go
to the Post Office and send
your tutor some mail.

You may want to refer to the
instructions in “Sending
FlashNotes, Files, and Mail,”
earlier in this chapter, If
you’re unsure of the tutor’s
address, you can find it in the
messages the tutor has posted
on the department message
board.

Getting help with studies




Creating pathnames
and prefixes

Sometimes when you are
downloading software, saving
a log of a particularly
interesting chat, or just
storing a file on a disk, you
need to tell AppleLink where
to find a particular file or
where to store one. A
pathname specifies the
location of the file.

The pathname provides a trail
of names leading first to a
disk, then perhaps to a
subdirectory or subvolume
within that disk, and finally to
the file itself. If you're
opening a file, the pathname
guides AppleLink right to the
disk, subdirectory, or file you
need. If you're saving a file,
the pathname tells Applelink
which disk to put it on, in
which subdirectory, and
under what filename.

Typing the same pathname
over and over can become a
chore. So when you're about
to save a number of files on a
particular disk, you may want
to set up a prefix—the first
part of a pathname leading to
the disk. AppleLink will keep
suggesting that prefix as the
location to which you want to
save your files, and all you
have to add is the particular
filename.

1. Begin with the disk

Start your pathname with a
slash, then the name of the
disk.

Each part of the pathname
begins with a slash.

If your disk were named
INTRO, then your pathname
would begin like this:

/INTRO

If you're not sure what the
name of the disk is, put it in
one of your disk drives and
use the option List Volumes in
the File menu. A volume is
any formatted area ready to
receive files; with floppy
disks, a volume is a disk.
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2. Add any subvolume
or subdirectory

If your file lies inside a folder
known as a subvolume or
subdirectory, add a slash and
the name of that subvolume
or subdirectory.

For instance, if your file is in
the subdirectory PARTY on
the disk INTRO, your
pathname would begin like
this:

/INTRO/PARTY

A subvolume is a part of the
disk (or volume) set aside for
a group of files; it has its own
list of those files.

The main list of files on a disk
is sometimes known as a
directory. Hence, this
subvolume is sometimes
known as a subdirectory. On
the Apple IIGS, the
subdirectory is shown as a
folder.
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3. Add the name of the file

Complete the pathname with
another slash, followed by the
name of the particular file.

For instance, if you were
saving the file FAVORS in the
subdirectory PARTY on the
disk INTRO, your pathname
would look like this:

/INTRO/PARTY/
FAVORS

When you are saving a file and
are asked to provide a
pathname, you can give your
file a new filename if you
want.

To set a prefix leading
to a disk or subdirectory

From the File menu, choose
Set Volume/Subvolume
Prefix.

Type the prefix.

If it’s to lead to the disk, type a
slash, followed by the disk
name.

If you want the prefix to lead
to a particular subvolume or
subdirectory on that disk, add
another slash and the name of
that subvolume or
subdirectory.

Press Return to accept the
prefix.

Later, when you're
downloading a file, saving
text, opening a log in a chat
room, or performing other
tasks with a particular file,
you’ll add a filename to the
prefix to create a complete
pathname for the file.

Creating pathnames and prefixes




Working with disks

Normally, you’d use your
System Utilities to format a
disk or to find out what a disk’s
name is or what files are on a
particular disk.

But you can do these tasks
without leaving the AppleLink
application—usually, without
even leaving the on-line
world.

To format a disk:

Get a brand-new disk that
you’re sure has nothing on it.

Start AppleLink. From the
Sign On menu, choose Work
Offline.

If you've been on line, press
Command-Q to sign off and
confirm by pressing
Command-2. Then press
Return.

From the File menu, choose
Format a Disk.

Specify the disk’s location.

If you don't know the slot and
drive numbers, press Esc
twice to leave this menu and
then choose List Volumes
from the File menu.

Name the disk.

Begin with a letter. To be safe,
make the name no longer
than 7 characters. You can
use letters, numbers, or
periods, but no other
punctuation. For details on
volume names, see your guide
to the System Utilities.

If asked to, place the disk in
the drive you specified earlier
and then press Return.
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To identify the disks
in your drives

ol

From the File menu, choose
List Volumes.

You see a list of the disks in
your drives. (A formatted
floppy disk is known as a
volume.)




To see what files
are on a disk

m On the File menu, choose Set
Volume/Subvolume Prefix.
Set the prefix to the disk you
want to examine and any
subvolume or subdirectory
you’re interested in.

m To see what files are on that
disk or in that subvolume or
subdirectory, choose Show
Catalog from the File menu.

Working with disks 67
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Handling files
on a disk

You may need to delete a few
files to make room for one
you intend to save; to set up a
new subdirectory (or
subvolume) to hold more
files; to give a file a new, more
accurate name; to lock or
unlock a file.

Normally, you’d use the
System Utilities disk to handle
these chores, but you can do
these tasks from within the
AppleLink application.

And once you’ve saved an
AppleLink file on a disk, you
can print it when you go off
line.

For information about
pathnames and prefixes,
please turn to “Creating
Pathnames and Prefixes,”
earlier in this chapter.

To create a subdirectory
or subvolume

If you are working on line, you
must sign off. Press
Command-Q to quit, then
press Command-2 to
confirm, and press Return to
g0 back to the Sign On menu.

Choose Work Offline.

If necessary, choose Set
Volume/Subvolume Prefix
from the File menu and set the
prefix to the disk or
subdirectory inside which you
want to create the new
subdirectory (or subvolume).

Choose Create Directory
from the File menu.

Name the new subdirectory
(or subvolume) and press
Return.

The subdirectory is itself a
file, so its name must follow
the conventions for ProDOS
names. Its name must begin
with a letter and may contain
up to 15 letters, numbers, or
periods, but no other
punctuation and no spaces.
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To delete afile

Whether you're on line or off,
choose Delete File from the
File menu.

Insert the disk with the file on
it.

Specify the location of the file
by typing its pathname. Press
Return to delete the file.

If the file is locked, you are
told that AppleLink cannot
write to the disk. In that case,
you'll need to cancel, then
unlock the file before deleting
308




LU UG L L Lt L Lt 4

To rename a file

Whether you're on line or off,
insert the disk containing that
file.

Set the prefix to the volume
and subdirectory containing
the file.

From the File menu, choose
Rename File.

Type the file’s current
pathname.

That's the pathname leading
to the file as it stands right
now, with its original name.

Tab to the next line.

If you're off line, type in the
new pathname, including the
new filename, then press
Command-2 to accept it. If
you'’re on line, type the new
filename (only) and press
Command-2 to accept it.

To lock or unlock a file

If you are working on line,
press Command-Q to sign
off, press Command-2 to
confirm, then press Return to
see the Sign On menu again.

Choose Work Offline.

If necessary, set the prefix to
the volume and subdirectory
of this file, using Set
Volume/Subvolume Prefix in
the File menu.

® From the File menu, choose

Show Catalog.

You see a list of files. The
name of any locked file is
preceded by an asterisk.

m To change the status of a file,

(to lock an unlocked file or to
unlock a locked one), choose
Lock/Unlock from the File
menu.

Type the name of the file and
press Return.

To print an Applelink file

From the Sign On menu,
choose Work Offline.

If necessary, set the prefix to
the volume and subdirectory
of this file, using Set
Volume/Subvolume Prefix in
the File menu.

From the File menu, choose
Print a Text File.

Type in the filename of the
file you want to print.

Applelink looks on whatever
disk is currently mentioned in
your prefix and if it finds a file
with the name you typed in,
Appleline prints the file.

AppleLink can print only its
own files and files that have
been saved in ASCII
(text-only) format.

To print files from another
application, use the
application itself.

Handling files on a disk 69




Downloading
and uploading files

You can draw software down
from AppleLink (that’s
downloading) or you can
send software up to AppleLink
for others to use (that's
uploading). You can
download and upload
software in areas such as the
Industry Connection, the
Apple Forums, or the
Software Center, all in the
Apple Community.

When you are downloading or
uploading large files (larger
than 40K), you may want to
use the AppleLink Conversion
Utility. This program
compresses files so they take
less time to transmit.
Download the utility from
Customer Service in General
Services or from the Software
Center in the Apple
Community. That way you
can compress files you're
uploading or uncompress the
ones you receive.

To find a file

If you have just signed on,
choose Apple Community
from the AppleLink Main
Menu. Then choose Software
Center from the Apple
Community menu.

From anywhere in AppleLink,
press Command-K for
Keyword or choose Use
Keyword from the Go To
menu. Then type Software
and press Return.

From the menu, choose a
subject area.

As needed, choose from the
subjects listed in submenus
until you see a list of files.

If necessary, scroll through
the list of files until you see the
one you warnt.
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To read about a file

To read a description of a file,
highlight its title and press
Return.

0

You can read about the file’s
contents, the operating
system or computer required
to use the file, and any utility
needed to convert it.

To read any additional
comments about the file,
follow the directions on the
screen to List Comments.

It’s a good idea to read about
a file before you download it,
to make sure it's designed for
the equipment you use. Your
computer can’t make sense of
software or documents written
for another operating system.
If you're not sure about your
operating system, look in the
guide that came with your
computer for information.
Still in doubt? Download the
file and give it a try or check
with an AppleLink Forum
leader for help.
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To download a file

With the description of the
file highlighted, press
Command-3.

You see a dialog box showing
the name of the file you
selected.

If you want to save the file on
the current disk in the current
directory, press Return to
confirm your decision.

AppleLink provides an
estimate of the time it will take
to download the file, then asks
for confirmation because
downloading a long file is
time-consuming. This is your
opportunity to change your
mind or to save the file to a
different disk or directory.

Once you confirm your
decision, AppleLink displays
a gauge with a pointer that
moves to show how much of
the downloading has been
completed.

To save afile in a different
disk or directory

With the description of the
file displayed, press
Command-5 to download the
file.

Follow the directions on the
screen to Set Prefix.

Type the new prefix in the
dialog box.

The prefix is the pathname up
to, but not including, the
name of the file. For
example, the prefix for saving
a file in a directory named
SOFTWARE on a disk named
MYDISK is

/MYDISK/SOFTWARE

Once the prefix is correct,
press Return to accept it.

Then continue the process of
downloading the file by
pressing Return again.

To save the file’s
description

m With the description of the
file displayed, press
Command-2, Save As.

® Type a full pathname in the
dialog box, ending with the
name you specify for the tile
containing the description.

m Press Return.

Downloading and uploading files
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Saving to disk

On a disk, you can save all
sorts of text—descriptions of
AppleLink departments,
calendar and schedule
information, opinions posted
on message boards, articles
from libraries, on-line chats.

In general, you should
prepare a disk to receive these
files and then set up a prefix
leading to that disk. (The
prefix is the first part of a
pathname. A pathname is a
series of names that leads the
operating system to a disk,
then to a subdirectory if any,
and finally to your file.) To set
the prefix, see “Creating
Pathnames and Prefixes,”
earlier in this chapter.

To download or upload
software, see “Downloading
and Uploading Files,” earlier
in this chapter.

To save a window of text

Display the text on your
screen and follow the prompt
to save it

You may have to wait until you
have received all the text.

Usually, you see a keystroke
combination, with the phrase
“Save As.”

m Type the full pathname,

including a filename for the
text you're about to save.

Press Return to confirm the
pathname and save the text.

Chapter 3: Using Applelink

To save mail

In the Post Office menu,
choose any option that deals
with mail.

Open the mail.

With the mail open, follow
the instructions on the screen
to Save As.

You must provide the
pathname for your new file,
including the disk name, any
subdirectory name, and the
actual name of the new file.
For instance, if you were
saving a letter about cash in a
subdirectory called PROFIT
on a disk named ANALYSIS,
the pathname would be

/ANALYSIS/PROFIT/
CASH




To save a chat

® From any chat room, press
Command-T to get to the
menu bar.

m Choose Open Log File from
the File menu.

B Type a pathname for the log
file, including a filename.

Press Return to start saving the
chat.

m Go back to the chat room and
press Command-T to be able
to chat again,

Your conversation will be
saved into a file on whatever
disk you've specified.

To stop the transcription,
choose Close Log File from
the File menu.

Saving fo disk 73
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Glossary

access: To make contact. You use a local access
phone number to make contact with an access
network, which then connects you automatically to
AppleLink.

Administration: Part of the AppleLink
University; go here to sign up for courses, to get
advice, and to find out other details about classes.

APDA™: The Apple Programmer’s and
Developer’s Association, a group that software
developers can join to secure various aids to
programming—resource files, utilities, manuals.
APDA has an area in the Apple Reference Library.

Apple Archives: An area of the Apple Reference
Library, containing transcripts from Apple
Auditorium events,

Apple Cafe: The place to chat with Apple
employees, located at Apple Headquarters.

Apple Collection: A store full of Apple-labeled
items, such as T-shirts, beach towels, and
mugs—at Apple Headquarters in the Apple
Community, and in the Mall in General Services.

Apple Community: The part of the AppleLink
on-line world that is devoted to Apple-related
products and news. Includes the AppleLink
University, Apple Forums, Apple Headquarters,
the Industry Connection, the Software Center, the
Reference Library, and Calendar and Events.

Apple Forums: Places to hear discussions, attend
conferences, download software, exchange
questions and answers on message boards—all
focusing on Apple users and on Apple products
and the hardware and software that work with

them.,

Apple Headquarters: A glimpse into life in
Cupertino—your place to get tips, news releases,
and product information, direct from the folks at
Apple.

AppleLink Conversion Utility: A program that
converts and compresses files for faster uploading
and packs several files together for easier transfer.
Located in Customer Service in General Services.

AppleLink University: On-line courses that help
you get the most out of your Apple hardware and
software.

Apple Press Releases: News releases from Apple
Headquarters.

ASCII: Acronym for the American Standard
Code for Information Interchange. This is the
code used by AppleLink for transmitting text from
your computer through the phone lines to the host
computer and back.

auditorium: An AppleLink area where you go to
hear panel presentations and guest lectures and to
attend a wide variety of special events.

Auto menus: In Customer Service, you can
choose to personalize your version of AppleLink.
One of the options is to establish whether menus
automatically appear open or closed when you
enter an Applelink department.

baud: A measurement of the speed at which signals
are transmitted—measured in bits per second.
Modems commonly communicate at 300 baud,
1200 baud, 2400 baud, and 9600 baud. AppleLink
communicates at 300, 1200, and 2400 baud.
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bit: A contraction of binary digit. The smallest
unit of information that a computer can hold or
transmit. The value of a bit (1 or 0) represents the
result of a simple choice between two
alternatives—yes or no, on or off, positive or
negative.

buffering: Temporary storage of incoming
information in a particular place in the computer’s
memory until it can be processed.

Calendar and Events: A department in the Apple
Community dedicated to telling you what’s
upcoming on line; includes a schedule of events
and Best Bets.

card: A printed circuit board that plugs into one of
the computer’s expansion slots, allowing the
computer to use one or more peripheral devices
such as modems, printers, or disk drives.

CCL: Short for Communication Control
Language, a programming language used to create
the files that control communication between your
computer, the phone system, and your modem.

chat room: An area where you can go for
conversation with anyone who chances by (a
public room) or with only your special friends (a
private room). Chat rooms are found all over
AppleLink: in clubs, forums, universities, the
People Connection, and other departments.

Classifieds: Advertisements posted by other
members at the Mall in General Services.

classroom: One of the areas in the AppleLink
University and the Learning Center where courses
actually take place. AppleLink University
classrooms contain some start-up materials, a
library in which you can look up information, a
message board on which you can link up with other
students, and some finish-up materials.

close: To put away a file, menu, or window.

club: An association of people interested in
pursuing the same interests on line; for example,
investing, genealogy, or fantasy games. Clubs are
lodged in the Club House in General Services.
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Command key: The key with an open apple or
propeller symbol on it. When pressed at the same
time as another key, this key issues a command to
the computer.

Comp-u-store Online: A catalog of products you
can order on line. You go to this store through a
gateway at the Mall in General Services.

conference: A meeting room where you can
participate in structured discussions. The club
host, forum leader, or guest speakers usually have
the floor, but you can ask a question or make a
comment, which is put into a queue.

Control Panel: A desk accessory that lets you
adjust the Apple IIGS when you set up your
equipment to work with AppleLink.

CR: Short for carriage return. Causes a printer or
display device to place the next character at the
left margin.

cursor: The blinking marker that indicates where
what you type will appear on the screen.

data bits: In the stream of bits being sent from
your computer to a peripheral device or another
computer, data bits are the bits that contain
meaningful information. They are distinguished
from bits used to indicate that a character is about
to start, has stopped, or is correct.

directory: A list of the contents of a subdirectory
or volume (disk). Contains the names, sizes, and
types of each file.

download: To transfer a file—a document or an
application—from the host computer to your
personal computer.

EAAsy Sabre: A simplified version of the airline
reservation system used by travel agents. Lets you
book flights, hotel and rental car reservations. In
the Mall in General Services.

echo: To send each character of your message
back to your monitor so you know it’s been sent to
another computer or to a printer. With AppleLink
you do not need the echo.
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Escape: The Esc key, used to close a window or
menu and go back to the menu or window you were
in before.

even parity: When transmitting a character in
binary code (a string of 1’s and 0’s), the use of an
extra bit set to 0 or 1 to make the total number of
bits an even number. Used as a means of checking
for errors when sending data from your computer
to a peripheral device or another computer. Not
needed when you sign onto AppleLink.

Express Yourself: A message board for
discussion of current events, found in the News
Room in General Services.

File menu: A list of commands letting you
identify the disks in your drives (List Volumes);
identify the files on a particular disk (Show
Catalog); set up a prefix leading to a particular
volume (disk) or subdirectory (Set
Volume/Subvolume Prefix); create a
subdirectory; and delete, lock, unlock, or rename
a file.

Financial District: A department in General
Services. Provides services such as business news,
stock quotes on StockLink, and investment
information.

FlashNote: A private note sent instantly to
someone who is currently on line; appears
immediately on the recipient’s screen.

forums: See Apple Forums.

gateway: A connection through AppleLink to a
service such as Comp-u-store Online. These
services may work differently than other AppleLink
services.

General Services: The part of the on-line world
devoted to general topics, hobbies, and activities;
distinguished from the Apple Community.
Includes departments such as the People
Connection, the Financial District, the Recreation
Center, the Club House, the News Room, the Mall,
Customer Service, and the Learning Center.

gRaFfItl: A message board on which you can
discuss anything from househunting to Elvis
gossip. Located in the People Connection in
General Services.

handshake: A means of establishing
communication with a peripheral device or
another computer.

headquarters: See Apple Headquarters.

Hollywood Hotline: A service providing the
latest show-business news. Located in the
Recreation Center in General Services.

host: The computer that controls all AppleLink
information and communication.

hourglass: An icon indicating that you must wait
because data is being transmitted between the host
computer and your computer.

icon: A visual representation of a department,
community, or service.

Identify: An option available in the Post Office
that lets you get information such as the hometown
of another AppleLink member.

Industry Connection: A department in the
Apple Community that puts you in touch with your
favorite companies to get answers, read news, see
software demos, and attend special events hosted
by these organizations.

key combination: Two or three keys that, when
pressed at the same time, issue a particular
command to the computer. For instance, pressing
Command-Esc closes all windows and menus
currently open.

Keyword: A shortcut for moving directly to
another location in AppleLink. For instance, after
you press Command-K, you could type the
Keyword News and go directly to the News Room.
A list of Keywords is available from the Apple (&)
menu.
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jumper: A block that allows electricity to jump
from one contact to another. On the Apple Super
Serial Card, this jumper block needs to be set so it
points toward the word MODEM when you plan to
connect the card to your modem.

library: An electronic collection in the form of a
database. You can search some AppleLink
libraries for a particular topic or word; others
provide a list of their contents, and you pick a title
from that list.

line feed (LF): An ASCII character that causes a
printer or display device to advance to the next
line.

line length: The number of characters your
printer or display device should put on each line
before going on to the next line.

locate: An option available in the Post Office that
helps you find the location of another AppleLink
member who is on line.

lock: To prevent a file from being renamed,
replaced, or removed.

log: A file that keeps a running record of
everything said in a particular chat session.
Initiated by the command Open Log File on the
File menu.

member: A participant in the AppleLink
Community.

Member Directory: A list of everyone who is
participating in AppleLink and who has agreed to
be listed. Located in the Post Office.

Members’ Online Guide: Provides detailed
advice on how to do almost everything. Located in
Customer Service.

message board: An area in which you can read
messages left by other members, and post your
own. Found in most departments of AppleLink.
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modem: Short for modulator/demodulator. A
device connected to your computer that
translates, or modulates, signals from your
computer so they can be sent over telephone
lines. It also demodulates the signals transmitted
from AppleLink so your computer can understand
them.

network: Any system that connects a number of
computers so their owners can communicate and
share information with each other. Telephone
access networks like Tymnet or Telenet take
messages from your local phone lines and speed
them to the AppleLink host computer and back,
letting you communicate with Apple owners
around the country.

odd parity: When transmitting a character in
binary code (as a string of 1's and 0’s), the use of
an extra bit set to 0 or 1 as necessary to make the
total number of 1 bits an odd number. Used as a
means of checking errors that might creep in when
you are sending or receiving information.

off line: Not connected to the network. Using
AppleLink’s Work Offline utilities, you can create
memos, handle disks and files, set up your
preferences, and get ready to go on line.

on line: Connected to the AppleLink network.

parity: The sameness of a level or a count, usually
the count of 1 bits in each character, used to check
errors that might creep in when you are sending or
receiving information.

password: The code provided to prevent
someone from using your account without your
permission; provided on your Registration
Certificate. You enter the password first time you
use AppleLink.

pathname: The full name by which an operating —
system locates and identifies a file. The pathname
specifies the path from the disk (volume name), =
through any subdirectories or folders, to the file
itself,
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People Connection: A department in General
Services that is full of on-line activity with other
members—conferences, special events, chat
areas, parties, and more; houses the Lobby, the
Auditorium, public and private rooms.

People menu: A menu in the chat area that gives
you options for listing, identifying, highlighting,
or ignoring other members in the chat area.

peripheral device: Any physical apparatus for
performing a particular task outside the main
circuit board of your computer; thought of as at
the peripbery of the computer. Examples: a
modem and a printer.

Phantasy Guild: A group of people who like to
participate in role-playing adventure games with
each other. Located in the Club House in General
Services.

port: A socket on your computer. For example,
your modem usually connects to the port with the
image of the telephone over it—the phone port.

Post Office: The on-line mail system with
branches in every department; lets you send a
FlashNote, an electronic mail message, or a file to
another member and obtain information about
other members with the Locate, Identify, and
Search Member Directory commands.

prefix: A stored pathname that precedes any
subdirectory name or filename you provide.

ProDOS: Acronym for Professional Disk
Operating System, an Apple II operating system
created to support subdirectories and large-
capacity disks.

pulse phone: A rotary-dial phone that gives off
pulses on the line, rather than distinct tones as on
a touchtone phone.

Reference Library: A department in the Apple
Community offering technical information,
descriptions of software for Special Education,
reviews of software, archives of Apple Forums, and
information from the Apple Developer’s and
Programmer’s Association (APDA).

registration: The process of establishing yourself
as a2 member of AppleLink; involves picking your
first screen name and choosing a method of
payment.

Registration Certificate: The piece of paper you
received in the AppleLink package, assigning you a
password and registration code.

RockLink: A service that delivers the latest
information in the world of rock and roll. You’ll
also find scheduled on-line conferences with
performers and writers from all over the world.

room: An area where you can go for conversation
with anyone who chances by (a public room) or
with only your special friends (a private room).
You can create your own private rooms, as
needed, in the People Connection in General
Services.

save: To preserve a document by storing it on a
disk.

screen name: Your handle. The name you go by
when you are on line. Can be all or part of your
real name or a fictitious name. You can have one
master screen name and up to four secondary
names.

serial port: The connector for a peripheral device
that uses data transmitted sequentially, one bit at a
time, over a single wire or channel. Examples: the
modem port and the printer port on the Apple Ilc.

session: The period of time during which you are
on line.

sign off: To disconnect from the AppleLink
network.

sign on: To connect to the network, going on-
line.

slot: A narrow socket inside some models of the
Apple 1I for connecting circuit boards that handle
communication between the computer and a
peripheral device, sending and receiving data
through a port, or plug, on the outside of the
computer.
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Software Center: A department in the Apple
Community devoted to providing you with public
domain software, shareware, and updates.

Sportsline: A service within SportsLink,
providing reviews, previews, columns, and
opinions about sports.

SportsLink: An area in which you can find news
about sports, message boards, and chat rooms for
discussion of hot sports topics. Located in the
Club House and the Recreation Center in General
Services.

StockLink: A service that provides you with
quotes on the stocks listed in the Wall Street
Journal, including current price, volume, open,
high, and low prices for the day; the previous
day’s closing prices; the earnings; and the
price/earnings ratio (P/E), dividend, and yield.

subdirectory: A file you create to serve as a folder
for a number of related documents. The
subdirectory has its own list of these documents, a
directory within the disk directory. Sometimes
known as a subvolume.

subvolume: A subdirectory. A formatted disk is
sometimes known as a volume. A volume contains
a directory of files, so a subdirectory may be
thought of as a subvolume.

Super Serial Card: A peripheral card that
provides the connection between a serial device
and the computer. A serial device sends and
receives information sequentially, one bit at a
time, over a single wire or channel.

telephone jack: An outlet into which you can
plug your phone cord or modem cable to send
signals out to the phone lines.

Top Ten: The ten most popular programs to
download from the Software Center.

touchtone phone: A telephone with a panel of
buttons, instead of a rotary dial; emits distinct
pitches, instead of pulses, when you press the
buttons.
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university: See AppleLink University or
University of Tomorrow.

University of Tomorrow: An on-line education
center that offers you instruction by qualified
teachers. Courses are taught in real-time
classrooms, and course materials are provided on
line.

unlock: To remove the restrictions placed on a
file when it was locked. An unlocked file can be
revised, renamed, replaced, or removed.

upload: To transfer a file—either a document or
an application—from your personal computer (o
the AppleLink host.

user group: An association of people who share
an interest in a particular aspect of computers.
You can take part in Apple Forums sponsored by
Various user groups.

volume: A general term referring to an area in
which you can store data. If you are using 3.5-inch
disks or 5.25-inch disks, each formatted disk is
considered a volume. If you are using a hard disk,
its manufacturer may provide software to divide its
storage area into several smaller areas, each
known as a volume.
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Academic American Encyclopedia
S, 58-59

account information 33

adding screen names 37

Apple Archives 56, 57

Apple Cafe 3, 48

Apple Collection 3

Apple Community 2-4, 52, 70

Apple Forums 3, 54, 70

Apple Headquarters 3, 48

Apple llc, preparing 15

Apple lle, preparing 15

Apple IIGs, preparing 13-14

Applelink Connect Guide x, 16,
28

AppleLink Conversion Utility 70

AppleLink University 2, 60-61

AppleLink Update 52

Apple menu 34

Apple Super Serial Card 15

Apple II System Disk 11

Apple II System Utilities 11

area codes 20

articles, saving/viewing 59

asking questions 56

As the Worm Squirms 46

Auditorium 4, 56

auditorium events, attending

56-57

B

Best Bets 4, 52

billing information 33

bulletin boards. See message
boards

Index

C

cable(s)
data 13, 16
power 13

Calendar and Events 4, 52-53
Call Waiting, disabling 17
canceling operations 39
cards, serial 15
characters
deleting 40
inserting 41
chat rooms
entering 48
leaving 49
spacing in 36
chats/chatting 48-49, 73
classes. See AppleLink University;
University of Tomorrow
Classifieds 46
clearing text 41
CLOSED 15
closing menus/windows 38
Club House 5
Command key combinations 31,
52
commands, using 30
computer. See hardware or specific
compuler
connecting modems 1617
Control Panel 13
conversations, joining 48, 50
Copy Files command 11
courses. See AppleLink University;
University of Tomorrow
crowds, picking people out of 49
Customer Service 5, 22, 23, 33,
34, 52, 70

D

data cable 13
defined 16
deleting
characters 40
files 68
screen names 37
departments
information about 34
initial 37
destination disk, defined 11
directory, defined 64
disk(s)
destination 11
formatting 66
identifying 66
source 11
working 11-12, 22
working with 6667
disk files. See files
Don't Miss 4, 53
DOWN 15
downloading files 43, 70-71

E

editing 40-41

electronic mail. See mail; Post
Office

encyclopedia. See Academic
American Encyclopedia

equipment. See hardware

escaping 38-39

Events. See Calendar and Events

Express Yourself 5

external modem 15

defined 16
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F

Fast Copy 11
files 6. See also Post Office
deleting 68
downloading 43, 70-71
handling 68-69
listing 67
locking 69
printing 43, 69
renaming 69
saving 72-73
sending 45
unlocking 69
uploading 70-71
Financial District 4
FlashNotes 6. See also Post Office
sending 44
folders. See also subdirectories;
subvolumes
creating 47
opening 46
formatting disks 66
forums. See Apple Forums

G

General Services 4-5, 52, 56, 60,
70

gRaFfIti 46

Grolier’s encyclopedia. See
Academic American
Encyclopedia

H

hardware
preparing 13-15
requirements ix
help 34-35

I

icons, using 30
ImageWriter/ImageWriter 11 13
IN 15
Industry Connection 3, 48, 54, 70
initial department, setting 37
inserting characters 41
internal modem 15

defined 16
Investor's Network 4

J
jumper, defined 15

K

keys, using 31

keystroke combinations, using 31,
32

Keywords, using 31

L

Learning Center 5, 60, 62-63
Let's Discuss 46

letters 6. See also Post Office
LINE 16

listings. See Calendar and Events
Lobby 50

local access phone numbers 17-22
locking files 69

M

MAIL 42
mail. See also Post Office
checking on 45
printing 42
reading 42, 43
receiving 4243
responding to 43
saving 42, 72
sending 44-45
mailbox flag 42
Mall 5
Member Directory 24
Members’ Online Guide 5, 34
menus
closing 38
turning on/off 36
using 30
message boards, using 46-47
messages, posting/reading 47. See
also Post Office

MODEM 15

modems
connecting 16-17
defined 9
external 15, 16

internal 15, 16
moving through text 41

N

names, screen 22-25, 37
network, described 10
News Room 5

(0}

OFF 15

off line, defined 1
ON 15

on line, defined 1
OPEN 15
opening folders 46
Opinion Poll 5
outside lines 19

P

password 22-25
pathnames, creating 6465
payment 22-25
people
meeting 50-51
picking out of crowds 49
People Connection 4, 48, 50, 56
personalizing the screen 36-37
Phantasy Guild 5
phone numbers, local access
17-22
phone port, defined 16
Phone Set Up box 19
port(s)
phone 16
serial 9
posting messages 47
Post Office 6, 4243, 44-45
power cable 13 _—
prefixes, creating 64-65
preparing =
Apple lIc 15
Apple Ile 15
Apple Ilcs 13-14 =
PRINTER 15
printer port 13
printing
files 43, 69
mail 42
private rooms, going to 51
public rooms, going to 51 —
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Q

questions, asking 56
quitting 39

R

reading

mail 42, 43

messages 47
receiving mail 42-43
Recreation Center 4
Reference Library 3, 58
registration 22-25
Registration Certificate 22-25
renaming files 69
requirements ix
rooms. See chat rooms; private

rooms; public rooms

S

saving

articles 59

chats 49, 73

files 72-73

mail 42, 72

text 72
schedule. See Calendar and Events
school. See AppleLink University;

University of Tomorrow

screen, personalizing 36-37
screen names 22-25

adding/deleting 37

searches/searching 58-59
sending
files 45 :
FlashNotes 44
mail 44-45
serial card 15
serial port, defined 9
Set Options 7
setting
initial department 37
switches 15
setting up 17-22
Set-up 7
Set Up Modem box 21
shortcuts 31, 32
signing on/off 28-29, 39
Sign On screen 7, 18
Software Center 3, 70
source disk, defined 11
spacing, in chat rooms 36
StockLink 4
Student Union 48
subdirectories. See also folders
creating 68
defined 64
subvolumes, creating 68. See also
folders
Super Serial Card 15
switches, setting 15
System Disk 11
System Utilities 11

T

Terms of Service 5
text
clearing 41
moving through 41
saving 72
transcripts 56, 57
transit number, defined 24
Tutoring Center 62-63
tutors/tutoring 60, 62-63
typing 40-41

u

University of Tomorrow 48, 60-61
unlocking files 69

up 15

uploading files 70-71

A\
volume. See disk(s)

W, XY, Z

windows, closing 38

working disk 22
creating 11-12
write-protecting 12

Work Offline 6-7

write-protecting 12

writing 40

Index 83



THE APPLE PUBLISHING SYSTEM

This Apple manual was written,
edited, and composed on a
desktop publishing system using
the Apple Macintosh® Plus and
Microsoft® Word. Proof and
final pages were created on the
Apple LaserWriter® Plus.
POSTSCRIPT®, the LaserWriter
page-description language, was
developed by Adobe Systems
Incorporated.

Text type is ITC Garamond® (a
downloadable font distributed by
Adobe Systems). Display type is
ITC Avant Garde Gothic®,
Bullets are I'TC Zapf Dingbats®.
Program listings are set in Apple
Courier, a monospaced font.
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